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Introduction 

This manual provides detailed information on how to use Ez3D-i. This document may not be 
reproduced in any manner without the prior written consent from the publisher. 

The user manual of Ewoosoft consists of 1) Product Installation and Server Manual, and 2) 
Product User Manual. It is recommended that users read this user manual thoroughly before 
using the program in order to learn the installation process of Ez3D-i S/W and the functions of 
the program. 

For supplementations, this manual is subject to change without prior notice. A printed manual 
distributed along with the product may not include contents specific to the latest version of the 
product. For additional information pertaining to this manual and the product, please contact us 
at: 

 

Ewoosoft Co., Ltd. 

▪ Website: http://www.ewoosoft.com 

▪ Tel.: +82-1588-9510 

 

About this document 

▪ Manual Name: Ez3D-i User Manual 

▪ Publication Date: August 2022 

▪ Manual Version: v5.4.1 

▪ Relevant Ez3D-i Version: v5.4 

▪ Manufacturer: Ewoosoft Co., Ltd 

 

User Notice 

▪ This manual is subject to change without prior notice for supplementation.  

▪ Several functions of Ez3D-i might be limited to use depending on countries and 
languages. 

▪ This document may not be reproduced in any manner without the prior written consent 
from the publisher. 

▪ To maintain seamless operation, user must read and follow the instructions prior to 
using Ez3D-i. 

▪ For the optimal use of Ez3D-i, the user must comply with the system requirements. 

▪ When transferring patient data such as images or information, laws and regulations 
on personal information in the country of use must be obeyed. 
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Product Information 

Product: Dental Imaging Processing Software for X-ray System 

Model: Ez3D-i 

 

801-ho, Vatechnetworks Bldg.,13, Samsung 1-ro 2-gil, Hwaseong-si, Gyeonggi-do, Korea  

Ewoosoft Co., Ltd. 

Website : www.ewoosoft.com MADE IN KOREA 

 

AVISO Bâtiment A 4ème étage 49 Quai de Dion Bouton 92800 Puteaux, France 

VATECH Global France SARL. 

 

 

Serial No. : Marked On the Product 

Software Version : Marked On the Product 

 

Standard 

Ez3D-i complies with the following international standards and regulations. 

 Manufacturer 

 Authorized representative in the European Community 

 
Serial Number 

 Prescription Device 

 
CE Marking 

 
Caution 

 
Consult Instructions for Use 

 

The prescription use statement as required by 21 CFR 801.109(b)(1) 

“Caution: Federal Law restricts this device to sale by or the order of a physician or any other practitioners 
licensed by the law of the state in which that person practices to use or order the use of the device.” 

 

Unique Device Identification (UDI) 

 
(01)08800019700340 
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Cyber Security 

Before installing the Ez3D-i, you must follow the instructions below for Cyber security.  

The instructions help to protect the program against cyber security threats such as viruses and 
malware. 

▪ Prior to installing and using Ez3D-i, scan your computer system with anti-virus and anti-spyware 

programs from a trusted source. 

▪ Install, set up and enable adequate anti-virus software. 

▪ Maintain up-to-date anti-virus software. 

▪ Make sure that your OS has the latest security updates applied. 

▪ Turn on your PC’s firewall. 

▪ Windows 10 or higher has a built-in firewall that is turned on by default. 

If you have any cyber-security-related concern or problem, please contact our customer support on the 
phone or via e-mail at the contacts listed below: 

▪ Tel.: +82 1588-9510 

▪ E-mail: gcs@vatech.co.kr  

▪ Website: http://www.ewoosoft.com 

 

 

mailto:gcs@vatech.co.kr
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The Main Functions of Ez3D-i 

Ez3D-i provides the user with the following functions using 3D VR based on patient’s CT image. 

▪ Diagnosis based on high resolution 3D VR 

▪ Simple and easy manipulation of 2D/3D image 

▪ 3D implant simulation 

▪ Powerful consultation using video contents 

▪ Customizable report creation using patient images 

Ez3D-i can be used in remote and local network environments with the exact same settings. If it 
has been installed on several PCs, the user can share the database for patient images and 
information in several workspaces. 
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License Plan Options  

Ez3D-i is available in a variety of plans in response to the users’ needs. Restrictions on provided 
tabs and functions may apply by the plans. Please contact our customer support to upgrade your 
license plan. 

Tabs available for each license plan are described below. 

Tab Lite Basic Advanced Endo 

Common (MPR/Section/3D PAN/Consult) O O O O 

TMJ X O O O 

SEGMENT X X O O 

ORTHO X X O O 

ENDO X X X O 

 

 

▪ In addition to the license plan above, Consult Premium license is required to use 
consult contents provided by Ewoosoft. A user without the license is able to view 
only user-added contents in Consult tab. 

 

Features available for each license plan are described below. 

Feature 
License Plan 

Lite Basic Advanced Endo 

Import 

Secondary CT X O O O 

STL Merging (Auto) O O O O 

3D Photo X X O O 

Export 

CT > STL (Export Surface Model) X O O O 

Edit STL Model (Bone Cutting, Add Object) X X O O 

Recon Ceph X O O O 

Image 

Tuning 
Filter (Windowing > 'VR') X O O O 

Implant Tooth Extraction X X O O 

Airway Measure Airway X O O O 

Not all features provided by Ez3D-i are listed above. Features other than listed above are 

available in all license plans. 
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1. Indications for Use 

Ez3D-i is dental imaging software that is intended to provide diagnostic tools for maxillofacial 
radiographic imaging. These tools are available to view and interpret a series of DICOM 
compliant dental radiology images and are meant to be used by trained medical professionals 
such as radiologist and dentist. 

Ez3D-i is intended for use as software to load, view and save DICOM images from CT, 
panorama, cephalometric and intraoral imaging equipment and to provide 3D visualization, 2D 
analysis, in various MPR (Multi-Planar Reconstruction) functions. 
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2. PC System Requirement for Ez3D-i 

The minimum and recommended system requirements to run Ez3D-i are as follows. 

Category Minimum Requirement Recommended Requirement 

CPU Dual-Core Processor @3.4GHz Quad-Core Processor @3.4GHz or Higher 

GPU 
NVIDIA GPU 

(GPU Memory: 1GB) 

NVIDIA GPU 

(GPU Memory: 4GB or Higher) 

RAM 4 GB 8 GB or More 

OS Windows 10 (x64) Windows 10 (x64) 

Display 1280×1024 1920×1080 or Higher 

Network 
100M Ethernet LAN(CAT 5 cable) 

or Wireless Network 802.11n 

1G Ethernet LAN(CAT 5E cable) or Higher 

or Wireless Network 802.11ac or Higher 

 

 

▪ The updated version of graphic card driver should be installed on user’s PC. 

 

For the users who use NVIDIA graphic card, go to [Control Panel > NVIDIA Control 
Panel > 3D Settings > Manage 3D settings] to add Ez3D-i. 

  

For laptop users, please set the ‘Select the preferred graphics processor for the 
program’ option as ‘High-performance NVIDIA processor’. 

 

It is recommended to set DPI Scaling level as 100%. 

1. Right click on desktop and select "Display Settings". 

2. Use the slider under "Change the size of text, app and other items" to change the 
DPI scaling level. 

3. Click the "Apply" button. 
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3. Before Use 

3.1 Installation of EzServer 

1. Execute MultiInstallUtility.exe. 

 

2. Multi Install Utility window for selecting installation mode will be shown. 

 

 

All items below must be installed to use all functions of Ez3D-i v5.4 by the PC types. 

▪ Server PC 

 EzServer v5.2 or Higher 

 Consult Data 

 Implant DB 

▪ Client PC 

 Ez3D-i 

 DAVIS Toolkit for 3D 

 

Integrated login function requires EzCommonTools that contains EzWebAgent, a custom 

browser provided by Ewoosoft, to be installed on the PC where Ez3D-i is installed on. 

When initially installing a product that uses the integrated login function, the installation of 

EzCommonTools is automatically executed after installation of the product. 

3. Select all items to install and click [Start] to install selected items in order. 
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3.2 EzServer Settings 

Log into EzServer Web Console using Master Admin account to set the server, manage user 

accounts. 

1. Right click on the Server Control Panel tray icon then, click [Show Server Control Panel] 
from the context menu. 

 

2. Click [Open Web Console] then, EzServer Web Console window appears. 

  

 

▪ EzServer Web Console is also accessible by executing EzLauncher and selecting 
EzServer Web Console. 
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3.3 Ez3D-i License Activation 

Activate the license using provided license key and enter user information to use all functions of 
Ez3D-i. The following License Activation Wizard appears when you run Ez3D-i without a license 
activated. 

 

See ‘Installation and Server Manual’ for more details. 
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4. Opening Ez3D-i 

Ez3D-i can be opened through EzDent-i or by double clicking the Ez3D-i icon on the desktop. To 
open Ez3D-i. 

4.1 Opening through EzDent-i 

1. Double click the CT images in EzDent-i.  

2. Ez3D-i is linked to EzDent-i and Ez3D-i will be opened automatically. 

4.2 Opening Ez3D-i directly 

1. Double click the icon of Ez3D-i on the desktop. Ez3D-i is executed.  

                 

>> Ez3D-i Icon          >> Run Ez3D-i 

 

When the Login function is enabled in EzServer, a login dialog appears. Enter ID 
and password then click [Login] to use Ez3D-i. 

 

User accounts can be added and managed through EzServer Web Console. See 
EzServer Web Console in ‘Chapter 2. Setting up Ez3D-i > 2. Environment > 2.1 
General’ for details. 
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2. The [Quick Settings] widow appears when the user run Ez3D-i for the first time after 
installation. With the [Quick Settings] window, the user can set Server IP Address, Setting 
Location (Local/ Server), Language, Teeth Code, VR Quality Mode and Skin Theme. 

  

3. Click the main menu and the [Open] menu. The following [Open Image File] window 
appears. 

 

4. Select a file in the folder and then click the [Open] button. The selected file will be loaded 
as follows. 
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5. Once the loading is complete, the first Ez3D-i screen appears as follows. 

 

 

 

If the VTFileManager, VTFileManagerAgent, VTPatchManager are running from the Tray 
icon, Ez3D-i will be running normally. 

VTFileManager is ON. 

 

VTFileManager is OFF. 

 

 

When there is changes in operating status of EzServer (VTFileManager, Database), a pop-
up message appears in the lower-right corner of the desktop. If EzServer is working 
properly, the pop-up message will not appear. 

When VTFileManager is not working 

 

When Database is not working 

 

When both VTFileManager and Database are not working 

 

When the connection with VTFileManager or Database Server is back to normal 
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4.3 Exiting Ez3D-i 

Click the [Exit] button in the upper right corner of the Ez3D-i. Ez3D-i is closed. 
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5. Utilizing Main Button 

The menus included in the main menu ( ) of Ez3D-i are Open, Save as project, 
Export, Go to 3rd party SW, Import, Export Surface Model, File info, Settings and About. 

 

5.1 Open  

1. Click the [Open] menu to open new DICOM file. 

2. The [Open] window appears, and then select a file to open. Click the [Open] button. The 
selected file appears in the workspace. 
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3. When multiple series exists in DICOM file, the following Load Multi Series Volume dialog 
appears. Select a series and click [OK] to open the series. 

 

 

5.2 Change Series (DCM with multiple series) 

 

[Change Series] menu is enabled only when Multi Series Volume is displayed in Ez3D-i. 

1. The following Load Multi Series Volume dialog appears 

 

2. Select another series to change and click OK. The changed series is applied to the screen. 
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5.3 Save as Project 

The current file can be saved with a different name. 

1. When the [Save as Project] window appears, input the project name and the comment, and 
then click the [OK] button to save. Click [Open Project] from MAIN MENU to check the save 
projects. 

 

 

5.4 Open Project 

Previously edited images (e.g., Annotation, lines, etc.) can be loaded to continue working on the 
project at a later time. 

1. The [Open Project] window appears. Select the project to open from the Project list and 
then click the [OK] button. The selected project appears in the Workspace. 
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5.5 Export 

Burn the working file on CD/DVD or save on the local disk. 

1. The [Export] window appears as follows. Click to select the location of the exported file in 
the Save Type section. 

 

 

Or, click [Export] icon on the toolbar to export the file. 

 

2. Click to select one of the File Compression options as follows. 

 

3. Select the type of file to export in the [Check to Export] section. DCM is the default file type 
for exportable files. 

▪ When exporting with [CT] option only, the exported file will be saved with the .dcm 
extension. 

▪ When exporting with [CT] and other options (Viewer, Project File, Secondary CT, 3D 
Photo) together, the project file will be saved with the .epf extension and CT files, 
Secondary CT files and 3D Photo files are saved in folders titled as CT, Secondary CT 
and 3D Photo respectively. 

4. Check [Create Zip File] option if needed. 

5. Select [Use] or [Not Use] for [Anonymize Patient Information] option. 

6. Click the [Export] button. 
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5.5.1 Save on CD/DVD 

1. Click [CD/DVD] on the Save Type. Click the [Export] button. 

 

2. The [Export] window appears as follows: 

  

3. When the process is complete, the [DISK BURNER] window appears as follows: 

 

4. After inserting empty CD/ DVD RW, click [Burn] to proceed with CD/ DVD burning. 

 

If no disk inserted, the following window appears. 
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5.5.2 Save on Local Disk 

1. Click [Local Disk] to select from Save Type, and then click the [Save] button. 

 

2. The [Save Document] window appears. Select a location to save, then click the [Save] 
button. 
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3. The [Export] window appears as follows: 

 

4. When the process is complete, the following Information window appears. Click the [Ok] 
button to save. 

 

 

5.6 Go to 3rd Party SW 

Files can be exported to other software such as NobelClinician and Simplant. 

1. Click a software to link from the submenu. The CT image will be sent to the selected 
software. 

 

▪ [Go to 3rd Party SW > Define volume range] function is to export the area after setting 
the certain area of volume. The file format exported through the [Define volume range] 
menu is DICOM, and it complies with the DICOM v3.0 standard. 

▪ Drag the mouse point in the [Preview] pane in the dialog to set the desired area and 
change the resolution. 
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5.7 Import 

Users can import the external model files, 3D Photos and Secondary CT files as well as check the 

files with the overlapped data. 

5.7.1 Import Model 

1. Select the [Import > Model] option. 

 

2. Select a file to import and click the [Open] button. 

 

3. The Registration dialog appears as follows. The imported data is automatically placed on 
the center of the axis. 
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4. Modify the position of imported data using controller on the 2D Views. 

 

5. Please press [OK] button to complete importing without fine tuning. If Fine Tune is required, 
please proceed the following steps.  

6. Data Type and Object Name of the selected model data is displayed on the left. 

 

7. Select the type of reference image to merge. 

 

 

Choose the [Model] option of reference Image for STL - STL matching. You can see all 
model data to select included in the Data Manager When you select Model option 

8. Click the [Fine Tune] button to adjust the location automatically by inputting three matching 
points. The Fine Tune dialog appears as follows. 
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9. Input three matching points on the Imported Data with the [Insert Matching Point] icon, and 
then on the Reference CT/ model data at the same positions with the Imported Data and in 
the same order. 

  

[STL- CT Matching] 

  

[STL-STL Matching] 

▪ The colors of inputted matching points differ by the inputting order. 
▪ You can click and drag the input points. 
▪ It is recommended to locate each point on the left, middle and right part of the model but 

not at the same height. 

10. Click the [Done] button when matching points are all inserted. 

11. The merged image with the imported data and reference CT image based on the three 
matching points on the Merged View. 

 

12. Click the [OK] button on the Registration Dialog. 
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5.7.2 Import 3D Photo 

1. Select the [Import > 3D Photo] option. 

 

2. Select a file to import and click the [Open] button. 

 

3. The Registration dialog appears. The imported data is automatically placed on the center of 
the axis. Modify the position of imported data using controller on the 2D Views. 

  

4. Please press [OK] button to complete importing without fine tuning. If Fine Tune is required, 
please proceed the following steps.   
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5. Click the [Fine Tune] button. Then the Fine Tune dialog appears. Input three matching 
points on the imported 3D Photo with the [Insert Matching Point] icon, and then on the 
reference CT data at the same positions with the imported data and in the same order. 
 

  

6. Click the [Apply] button when matching points are all inserted. 

7. The merged image with the imported 3D Photo and reference CT image based on the three 
matching points on the Merged View. 

  

8. Click the [Ok] button on the Fine Tune dialog. 

 

5.7.3 Import Secondary CT 

1. Select the [Import > Secondary CT] option. 
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2. Select a file to import and click the [Open] button.  

 

3. The Import Secondary CT Dialog appears. The imported data is automatically placed on 
the center of the axis. Modify the position of imported secondary CT using controller on the 
2D views. 

  

4. Please press [OK] button to complete importing without fine tuning. If Fine Tune is required, 
please proceed the following steps. 

5. Click the [Fine Tune] button. Then the Fine Tune dialog appears. 
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6. Define corresponding regions on the both Primary and Secondary CT by dragging and 
dropping the points on the boxes shown on the following picture. 

  

7. Click the [Apply] button when the adjustment is completed. 

8. The merged image with the imported secondary CT and reference CT image based on the 
defined regions on the Merged View. 

  

9. Click the [OK] button on the Registration dialog. 

 

The secondary CT does not show on the View after registration. Please conduct the 
superimposition function to view the registered the secondary CT data with the primary CT 

on the view. Please refer to ‘Chapter 4. MPR Tab > 13. Superimposition’.  
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5.7.4 Import Epf File 

1. Select the [Import > Epf File] option from the Main Menu. 

 

2. Importing an EPF file will lose the existing data in progress. Click OK to proceed when a 
warning message appears. 

3. Select a file to import then click Open. 

 

4. The file currently working is updated with the imported file. 

 

 

Only an EPF file created from the same patient image can be imported. When the file to 
import is created on a different CT image, the import function is canceled. 
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5.8 Export Surface Model 

User can export the data displayed in 3D view to STL file. 

1. Click the [Export Surface Model] button. The [Export Surface Model] dialog appears. 

 

2. Select the format of file, quality, and option to export. 

▪ File Format: Choose the file format when exporting data between Binary and ASCII. 

▪ Smoothing: Smooth surface when exporting CT files with the selected level. 

▪ File Size: Reduce file size to the selected percentage when exporting CT files 

▪ Export Data: Select data type to be included to the exported data 

▪ CT Number Threshold: Adjust areas of CT number threshold 

 

▪ [Smoothing], [File Size] and [CT Number Threshold] option only activated when 
exporting data including CT. 

▪ Changes in selecting [Export Data] option are directly applied on the Preview right after 
the user re-select the [Export Data] options. 

▪ The [With Implant Path] ad [With Implant Guide] option can be selected only when 
choosing the [With Implant] option 

  



Chapter 1. Ez3D-i Basics  

44 Ez3D-i User Manual 

3. Click the [OK] button and the dialog to set a file name and the path appears as follows. 

 

4. Input the name of file and select the file type. 

5. Click the [OK] button and the following windows appear. 

  

When the exporting is completed, the progress bar disappears, and the program is 
available to use. 

 

▪ The Export Surface Model menu is available only in the tab where 3D View 
Window is provided. In the tabs or layouts that do not provide 3D View Window, the 

Export Surface Model menu is disabled. 

▪ When exporting a surface model, only the sculpting currently applied to 3D image 

will be exported. The clipping applied to current 3D image will not be exported. 
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5.9 Export Recon Ceph 

The Ceph Reconstruction function displays a layout to view Ceph images of different ranges as 
needed for patient counseling. 

1. Select the [Export Recon Ceph] from the Main Menu. 

2. Recon Ceph dialog appears as follows. 

 

5.9.1 Exporting Recon Ceph Image to the Server 

1. Set the Save Option as [Server] and click the [Save] button to export the Recon Ceph 
image to the server. 

2. Ceph image is created, and a progress bar is displayed until saving is completed. 

 

1. The progress bar disappears, and the file is completely saved. 

 

▪ Only the CT image opened from EzDent-i can be exported to the server. 

▪ The modality is automatically set as Cephalo. 

▪ The position(Lateral, PA, and SMV) of the image is automatically set in response to 

the selected image type.  



Chapter 1. Ez3D-i Basics  

46 Ez3D-i User Manual 

5.9.2 Exporting Recon Ceph Image to the Local PC 

1. Set the Save Option to the [Local] and click the [Save] button to export the Recon Ceph 
image to the local PC. 

2. Set file path, file name and file format in Save dialog. The supported file format is JPEG, 
BMP, PNG and TIF. 

 

3. Click [Open] button to terminate both Save dialog and Recon Ceph dialog. 

4. Ceph image is created, and a progress bar is displayed until saving is completed. 

 

5. The progress bar disappears, and the file is completely saved. 
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5.10 File Info 

Patient information, file data, and image data of the corresponding file can be obtained. Patient 
information contains the patient ID, patient name, gender and age. File data contains the file 
type, resolution, data size, and file size. Image data contains the image acquisition date and the 
amount of the radiation dosage. 

 

 

To show the patient name properly, click the dropdown menu of the [Encoding Name] 
option and select the desired encoding option. 

 

Patient information displays according to the anonymization setting for each option on 
Settings. 

5.11 Settings 

[Settings] provides the user with general setting preferences necessary for using Ez3D-i. For 
details, see ‘Chapter 2. Setting up Ez3D-i’. 
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5.12 About 

The program version, company name, license information, UDI information, and product labels 
by countries for Ez3D-i are listed. 

 
 

5.13 Logout 

 

▪ When logged out from Ez3D-i, the account will be logged out from all other products 
using integrated login. 

The current account is logged out from Ez3D-i. When the Login function is disabled in Server, 
the item is being hidden. 
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1. Reset the Settings 

Setting values of Ez3D-i can be reset by clicking [Reset the Setting] button.  

1. Click [Reset the Setting] button at the left bottom of Setting dialog. 

 

2. Click OK button when the following warning dialog appears. 

 

3. Restart Ez3D-i to apply changes. 
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2. Environment 

2.1 General 

 

▪ Setting Location 

Select an option for setting location of the Ez3D-i Viewer setting. 

• [Local]: To apply the settings separately from the Server PC, select the [Local] option. 

By clicking the [Sync] button, the settings from the Server PC will be applied, but some 

options can be set separately if necessary. 

• [Server]: To apply the settings of Server PC, select the [Server] option. 

• [Sync]: The [Sync] button is activated only when the Setting Location is [Local]. 

 The settings of the Server PC will be applied by clicking the [Sync] button, 

 but the following options can be set separately from the Server PC settings. 

 Environment 

- General: Location & Theme settings 

-   Database: All options 

-   Linkage/E-mail: 3rd Party Software 

 View 

- General: VR Display Quality 

 DICOM 

▪ General 

The user can set the program’s language environment, font, tooth code, and dose unit. 

 

Some fonts may not be available for certain languages. 
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▪ Save Option 

• Project save option 

When exiting the Ez3D-i program, you can save the project manually or automatically. 

 [Auto Save]: The project is saved automatically. 

 [Manual Save]: When exiting the program, the following window appears: 

 

Click the [Save] button to save the changes and click the [Don't Save] to cancel 
the changes. The program will not close with the [Cancel] button. 

 

The project will be saved automatically regardless of the project save option in case 
of exporting with the [Project File] option. 

 

• Captured image save option 

Set up the location to save the captured images. 

 [Auto save to image server]: The images captured with Ez3D-i will be 

automatically saved for both EzDent-i and Ez3D-i. 

 [Manual save to image server]: The images captured with Ez3D-i will be 

automatically saved for Ez3D-i and can be sent to EzDent-i manually. 

 [Manual save to local]: The images captured with Ez3D-i can be saved locally to 

the selected location and will be automatically saved for Ez3D-i. 

 [Send to PACS]: The images captured will be saved automatically on both Ez3D-i 

and a PACS Server. 

 

 

The captured images will be properly saved according to [Captured image save 
option] only when the Ez3D-i is linked with EzDent-i and EasyDent4. 
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▪ Skin Theme 

Ez3D-i provides 3 different skin themes of Green, Professional and Modern. 

• Green 

 

Without selecting any other option, Natural skin will be applied as the default theme. 

• Professional 

 

• Modern 
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▪ Server Web Console 

Click [Link] to open EzServer Web Console to set server settings including managing user 

accounts, enabling/disabling Login function and setting the security code. See ‘Installation 

and Server Manual’ for details. 

• Restrictions on Authority by Account Types 

When the Login function is enabled in EzServer, restrictions may apply on using 

functions of Ez3D-i by accounts logged in.  

Account Features Not Allowed 

Master Admin  None 

Admin  User Account Manager 

Doctor  User Account Manager, Delete Data, Edit Shared Data 

Staff  
User Account Manager, Delete Data, Add and Edit Data, Transfer Data, 
Export Data, Edit Shared Data 

• Security Code 

If the Security Code function is enabled in EzServer and functions to apply are selected, 

a dialog asking the security code appears when using corresponding functions. If the 

current user logged in is authorized and the Security Code function is disabled, the 

corresponding function is executed without asking the security code. However, the 

Security Code function cannot be disabled while the Login function is disabled. 

The initial security code is set to numbers ‘0000’ and the code can be changed in 

EzServer Web Console. 
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2.2 Database 

  

▪ Server Setting 

If Ez3D-i is used as Server, input "127.0.0.1" or click the [Search Server] button and select 
the corresponding IP address. 

If Ez3D-i is used as Viewer, check the IP address of Server PC and input the corresponding 
address. At this time, the IP address must be the IP address of Server PC, not the IP 
address entered for Server setting (127.0.0.1). Click the [Search Server] to display the list 
of the IP address that are connected to LAN (Local Area Network). Select the proper IP 
address from the list and the address will be automatically entered into the input field. 

 

It is recommended to set with a fixed IP address when setting IP address. 



Chapter 2. Setting up Ez3D-i 
 
 

Ez3D-i User Manual 57 

2.3 Linkage/E-Mail 

  

▪ Linkage 

• 3rd Party Software 

User can select the linked program that can send the data in use. 

• Path for 3rd Party Software 

Browse and set the path of the selected program for [3rd Party Software] option. If the 
path is not property set, the relevant program on the [Go to 3rd party SW] menu will not 
be activated. 

• Linkage Software for Toolbar 

Select the Create Movie Clip to create a linkage with the movie capturing program. 

• Path for Linkage Software for Toolbar 

Browse and set the path of the selected program for [Linkage Software for Toolbar] 
option. Once the path is set, the [Create Movie] icon on the toolbar will be activated. 

▪ E-Mail Sender Information 

Users can send a test email from the saved user account. To do this, the email address, 
name, password and other related information are required. 

 

To use the Email feature properly, you must configure the IMAP/POP3 setting from the 
sender's email account. In the email setting, change the POP3 and IMAP setting to [Enable]. 
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• SMTP Server Address 

If the domain of the user's email address is predefined by Ez3D-i, the SMTP Server 
address will be automatically filled with the default value. 

To use the different email server, input the server address directly into the field. 

• Port 

The default setting for the Port is 25. To use different port number, input the port 
number as desired. 

When the domain information, such as Naver, Gmail, or AOL, is saved in Ez3D-i, the 
Port number is entered automatically and cannot be modified. 

• Security 

Select the encrypted connecting method that is used when sending emails. 

 

The provided Security options are as follows: None, Auto, SSL, and TLS. The 
default setting value is Auto, but the user can change the option as desired. 

But, when the domain information, such as Naver, Gmail, or AOL, is saved in 
Ez3D-i, the Security value is entered automatically and cannot be modified. 

 

2.4 Clinic Information 

 

▪ Clinic Information 

The user can input their clinic information such as the name of the clinic, website address, 
phone number, fax number, address, clinic logo, and image. The report reflects the 
information entered. 

▪ Clinic Logo Type 

Once the clinic logo (image file) is registered, it appears at the bottom left of the Ez3D-i 
screen by default. The saved logo will be used in the reports as an advertisement. 
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3. View 

3.1 General 

 

▪ VR Display Quality 

 High Quality 
When PC recommended specification is met, user can set up the VR quality as high 
performance. 

 Performance 
The rotation speed of an image compared to the VR Quality can be set with the 
[Performance] option if the PC specifications are lower than the recommended 
specifications. 
The [Fastest Speed] option displays the images in the minimum definition, and the 
[Fast Speed] option maintains VR quality as middle level. When it is set to [Fastest 
Speed] option, the image is displayed with its best quality. But when VR is not moving, 
the quality is displayed with the best quality. It is recommended to test the PC level 
before utilizing the software. 

▪ Direction Guide 

 Guide Type 
The guide type that displays the direction of 3D images, Field of View (FOV) size, and 
the acquisition point in the MPR tab can be set to be either Skull or Cube. 

▪ Windowing 

User can select the Windowing option to use for Ez3D-i. 

 Windowing Option 

 [DICOM Tag] : applies the Window Width and Window Level values that are 
stored in the DICOM file.  

 [User Define] : The user can specify and set up the User Define directly. 

 Windowing Filter 
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 Set the filter as default. Refer to ‘Chapter 4. MPR Tab > 3. Adjusting 2D Images’ 
for how to set filters. 

▪ Grid 

The default setting values of the spacing, line color, line thickness or the line opacity of grid, 
which is on the tool bar in MPR, SECTION, 3D PAN, and TMJ tabs, can be set. 

3.2 3D View 

 

▪ 3D Volume 

The user can set the 3D image preferences. The Smart View size is the actual size of the 
magnified 3D images, and the Default Zoom is the default magnification of the 3D image 
when it is first opened. 

▪ VR Coloring Adjustment 

With the adjusting VR coloring function, users can set up the default value in various 
modes. 

• Default Setting 

Click the [Default Setting] button and the following window appears. 

 

Click the [OK] button to change Preset VR Coloring values for the 3D images. 
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 Setting default coloring value for each model 

 

Select a model from the dropdown list and set the default coloring value for each 
model. 

- If the acquisition device saved in the DICOM file is not in the model list, the 
coloring values of images will be displayed with the default value. 

- VR Coloring values cannot be set in MIP mode. 

- Click the [Range Setting] button to set the minimum and maximum values of 
the range of graph to be displayed. 

- Click the [Save as Preset] button to set the current settings as a preset. 

 Importing VR Coloring Graph 

Click the [Import Graph] button to open the saved graph file. The acquisition 
equipment and the values saved for the equipment will be shown. 

 Exporing VR Coloring Graph 

Click the [Export Graph] button to save and export the current graph values to the 
local PC. 

• Opacity 

Move the slider to adjust the opacity of 3D images. With lower opacity, the image is 
more transparent, and the inserted structure is displayed clearer. 

• Brightness 

Move the slider to adjust the brightness of 3D images. Higher number displays the 
brighter image. 

• Contrast 

Move the slider to adjust the contrast of 3D images. 

• Secondary CT Color Theme 

Select default color theme for secondary CT data. 

▪ 3D MPR Plane 

• Display Option 

User can set to turn on or off the MPR Plane, which is displayed in 3D View. 

• Plane Type 

User can set the display type of MPR Plane. 

▪ Curvature 

• Indicator Display Option 

Show/hide the circle indicator overlay. 
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3.3 2D View 

   

▪ MPR View 

The user can set the values of default thickness, basic scale of zoom, interval in 
Axial/Coronal/Sagittal View and color theme of secondary CT data. 

▪ Panorama View 

The user can set the default thickness, spacing, height, and the basic scale of zoom for 2D 
images in Panorama View. 

▪ Curve- 

 Sectional Line Display on Panorama View 

 Show/hide the sectional line on Panorama View in Section tab. 

 BL/LB Display Option 

Click the checkbox of [Apply BL/LB] to select the option, and then the L (Lingual)/ B 
(Buccal) indication marks will be created on the curves in the SECTION tab. The user 
can change the display location of L/B mark, and the L/B position of slice image will be 
changed depending on the L/B mark. 
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3.4 Navigator 

  

▪ Volume Panorama Navigator 

Set the default size, thickness, and the interval of the Navigator displayed in the Volume 
Panorama view of the 3D PAN tab. 

▪ Endo Navigator  

Set the default size, thickness and interval of the Navigator displayed in Endo Tab 

▪ TMJ Navigator 

Set the default size, thickness, and the interval of the Navigator displayed in the TMJ tab. 
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4. Measurement/Annotation 

4.1 Measurement 

  

The user can set the default color for angle, length, profile and circle, and the font size for 
measurement. 

 

4.2 Annotation 

 

The user can set the line color and style of Free Draw. The user can also set the color, the 
background color, the transparency of memo, the color and the thickness of pointer. Click the 
[OK] button to save the selected measurement and annotation. 
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5. Simulation 

5.1 General 

    

▪ Implant Fixture  

The user can set the default color of implant and crown. 

▪ Collision Detection 

Click on the radio button to enable the collision detection. When the collision detection is 
set to [Use], the Implant Safety Zone and the boundary size can be set. 

• Implant Safety Zone 

User can set to display or hide the minimum space required for implant insertion. 

• Boundary Size of Safety Zone 

User can set the size of Implant Safety Zone. 

▪ Canal 

The user can set the default diameter and base color of the Canal. 

▪ Root Canal 

The user can set the default diameter of Root Canal. 
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5.2 Implant 

  
▪ Preset Implants 

For the implant simulation, the user can set the default implant value according to the 
number of teeth. To change the default implant for the selected number of tooth, click the 
[Modify] button and the [Modify Implant Set] dialog appears as follows. Set multiple teeth to 
apply the same implant on them concurrently. 

 
In the [Modify Implant Set] dialog, the user can check the default implant for the selected 
number of tooth, and set the Implant Company, product family, and model name regarding 
the default implant value according to each tooth number. 

▪ Recommend Implants from 

Ez3D-i recommends implants to insert based on the [Recommended Implants from option] 
while implant simulation with mouse right-clicking after length measurement. 

By selecting [Preset Implants] option, Ez3D-i recommend implants among preset implants 
while by selecting [Implant Company] option, Ez3D-i recommends implants among implants 
of the selected company. 

▪ Implant Long Axis 
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• Display Option 

The user can select whether to display implant long Axis or not. 

• Long Axis Size 

The user can set the size of Long Axis between 5, 10, 15, 20, 25, 30, 35, 40, 45, and 
50. The default value is 20 mm. 

5.3 Implant Guide 

    

▪ Implant Guide 

• Guide Length 

User can set the default length for Implant Guide 

• Offset 

User can set the default offset between Implant and Implant Guide 

• Outer Diameter 

User can set the default outer diameter for Implant Guide 

• Inner Diameter 

User can set the default inner diameter for Implant Guide 

▪ Implant Path 

• Path Length 

User can set the default length for Implant Path 

• Path Diameter 

User can set the default diameter for Implant Path 
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5.4 Bone Density 

  

▪ Bone Density Type 

The bone density values can be set by acquisition equipment. 

▪ Bone Density Color and Area 

User can set the color for each Density range that is displayed for Bone Density effect in 
Windowing group of the 3D PAN tab. 

 

Adjusting bone density range depending on the equipment that you have is required to use 
the bone density function more accurately. (There are many cases where CBCT has 
different CT Number values, which are the standard of bone density standard, depending on 
the equipment.) 

Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 
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5.5 Airway 

  

▪ Airway Level Color 

Set the range to apply to the Airway Volume, which is displayed with the [Airway 
Measurement] function in the MPR tab, and the color for each level. 

The Airway Level Color is used to visualize the area (㎟) for each Axial slice in the 

measured Airway area. The color for total of six level (L1 ~ L6) can be set, and the range 
for each level is set based on the minimum area value and the increment. 

The minimum area value refers to the minimum area (unit:㎟) of Airway area, and the 

increment refers to the value of the increased area (unit:㎟) by each level. 

[Ex] If the minimum area value is 100 (unit:㎟) and the increment is 50, the Airway Level 

Color (L1~L6) means as follows. And if the area of the Airway in the Axial Slice is 125㎟, 

the mixed color of L1 and L2 is set. 

 L1 color is used when the Airway area in the Axial slice is below 10㎟. 

 L2 color is used when the Airway area in the Axial slice is 15㎟. 

 L3 color is used when the Airway area in the Axial slice is 20㎟. 

 L4 color is used when the Airway area in the Axial slice is 25 ㎟. 

 L5 color is used when the Airway area in the Axial slice is 300㎟. 

 L6 color is used when the Airway area in the Axial slice exceeds ㎟. 
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▪ Sensitivity 

To adjust the degree of the Prevent Leak function, click the dropdown menu of the [Prevent 
Leak] to select the [Use Correlation Method] option. When the [Sensitivity] option is set to 1, 
the Prevent Leak function is applied with the weakest degree. Set the [Sensitivity] option 
higher to apply the Prevent Leak function with stronger degree. 

▪ Prevent Leak 

Set the default value for the function that removes the areas, which are not part of the 
Airway. 

The parts, which is not the Airway, may be measured in the CBCT image due to the 
artifacts made from metal, etc. To prevent this, use the Prevent Leak function to remove the 
areas, which are not part of the Airway. 

 

Using the Prevent Leak function increases the time needed for 
Airway measurement. Also, if the Metal artifact is severe, the 
function may not work. 

 

• 3D Rendering 

  

Prevent leak function not in use Prevent leak function in use 

• Axial Image 

  

Prevent leak function not in use Prevent leak function in use 
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▪ Maximum Airway ROI Width 

Click the starting point and the ending point of the Airway to measure and a square (ROI) 
will be created based on the center point of the two selected points. The Airway is 
measured within the square (ROI). 

Change the number of Maximum Airway ROI Width to widen or reduce the Airway area. 

 

 

5.6 Endo 

  

▪ VOI 

Set the size and color of plane displayed in VOI view in ENDO tab. 

▪ Curvature Level Color 

Set the size and color of curvature circle radius displayed in VOI view in ENDO tab. 

 

L1 corresponds to the minimum radius and L6 corresponds to the maximum radius. 
Color gradient value applies between levels. 

Radius size smaller/larger than the Min./Max. Radius is displayed as a circle with 
the minimum/maximum radius. 
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6. Ortho 

6.1 General 

  

▪ Data 

The user can set the default opacity of original position of Data. The default value for 
Default opacity of original position is 70% and the values can be set in the range between 0 
and 100% (10% intervals). 
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7. Consult 

7.1 General 

  

▪ Pointer 

The user can set the line style and color of the pointer. 

▪ Grid 

The default setting values of the spacing, line color, line thickness or the line opacity of grid, 
which is on the tool bar in the CONSULT tab, can be set. 
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8. Report 

8.1 General 

 

▪ Color Setting 

The user can set the background color of reports. The color only applies on the screen but 
does not apples when printing out the report.  

▪ Text Box 

The user can set the font type, font size, font color, background color, border style, and 
border color of the text box. 

▪ Image Box 

The user can set the border style, background color, and border color of the image box, and 
also display or hide the ruler and acquisition information. 

▪ Grid 

The user can set the interval of grid.  
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8.2 Annotation 

   

▪ Drawing 

The user can select default values for Drawing tools. Color and line style can be set for 
each annotation tool. 

▪ Memo 

The user can set the default values for Memo tool.  
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8.3 Reference Guide 

    

▪ Reference Guide Overlay 

Default values for overlays displayed on reference guide can be set. Slice number interval, 
and line thickness and color of section indicator line, section line, and sectional axis can be 
set. 

Enable [Sectional Axis Line On] to display the center line of a curve in a scout view of 
reference images when creating a report. 

  



Chapter 2. Setting up Ez3D-i 
 
 

Ez3D-i User Manual 77 

9. DICOM 

9.1 DICOM Print 

  

▪ DICOM Print 

Select an option of whether to use DICOM Print. 

▪ Print Setting 

From the Print Setting list, user can check the registered DICOM Print. 

▪ To add DICOM Print 

1. Click the [Add] button. 

2. Input the DICOM Print information in the [Add DICOM Print] dialog. 
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▪ To calibrate DICOM Print 

1. Click the DICOM Print for calibration in DICOM Print list. 

 

2. Click the [Calibration] button. 

3. Change the values in the [Page Calibration] dialog, and then click the [Save] button. 

 

 

▪ If the fields for calibration values are left empty, the following message appears. 

 

▪ One DICOM Print should be in one size and one calibration value. To register 
different size and calibration value, add a new DICOM Print. 
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9.2 DICOM Sending 

  

▪ Storage Server List 

The Storage Server List shows the list of registered Storage Server.  

To add Storage Server, click the [Add] button. When the [Add Storage Server] dialog 
appears, input the Server information and click the [Connection Check] button to check if 
the storage server is connected. Then click the [Save] button. 
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10. Privacy Policy 

10.1 Privacy Policy 

   

▪ Privacy Policy Setting 

The user can select whether to user the privacy option or not. 

▪ Anonymize Information Displayed on Screen 

The user can select options to display on screen without anonymization. This option is 
enabled when Privacy Policy Setting is ‘Enable’. 

▪ Anonymize Patient Information 

The user can select whether to apply anonymization function or not for each option. For 
options checked, related UI appears when running each function. 
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10.2 Manual Segmentation 

 

The user can set default values for manual segmentation. 

▪ Marking Overlay 

The user can set the color and opacity value of marking overlay. 

▪ Brush and Eraser 

The user can set the default size of Brush and Eraser. 

▪ ROI 

The user can set the default size of ROI. 

▪ Smoothing 

The user can set default values of Smoothing.  
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1. Utilizing Smart Click for 3D Images 

Double click an area of the 3D image to magnify the image. Corresponding movements of Axial, 
Sagittal, and Coronal images appear on the screen. 

1. Double click on the part of the 3D image that the user wishes to view. 

  

2. The 3D image is rotated and magnified based on where you double-clicked. 

  

3. Press the ‘Ctrl’ key on your key board and double click on the image. The 3D image returns 
to the default ratio set in the Settings. 
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4. The corresponding view of Axial, Sagittal, and Coronal images appears according to the 
movement of 3D images. 

              

 To rotate the 3D image while maintaining the enlarged rate, click the Predefined direction 
buttons or drag the 3D image. 

 Use the mouse wheel to enlarge or reduce the size of the image. 

 To make the axis disappear from the screen, click on the screen and then press the 
Spacebar from the keyboard. When pressing <Space bar> once more, the axis is on. 

 

 

When there is not enough memory, only the part of the image may be shown on the screen. 
In this case, the compression rate is displayed on the MPR View. 
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2. Controlling Direction of 3D, VR Images 

Click the Predefined direction button or drag the 3D image to change the direction of the 3D 
image. 

When clicking the head image button at the bottom of the 3D realm, the 3D image is rotated to 
the indicated position. 

 

 If the DICOM header file exists, the pink box on the Skull appears to indicate the 3D capture 
area in relation to the entire view of the skull. 
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3. Adjusting Axis of 2D Image 

From a 2D image, the user can adjust the axial view of the selected tooth. The user can check 
the structure of the surrounding teeth by using the mouse wheel. 

 

Show and hide the axis of the 2D image 

Press the Space bar on the keyboard on the selected images to hide or show the axes. 

3.1 Adjusting Two Axes Simultaneously 

1. Hover the mouse to the point where two axes intersect, the cross-cursor shape  
appears. 

 

2. Click and drag to move the two axes of the tooth selected. 

3.2 Adjusting One Axis 

1. Hover the mouse on one axis and the arrow shape cursor  or  appears.  

  

2. Click and drag to move the axis of the selected tooth. 

 

 

 

 

 



Chapter 3. Basic Functions 
 
 

Ez3D-i User Manual 89 

3.3 Rotating Axis 

1. Hover the mouse on an end point of the axes and the arrow cursor  appears. 

 

2. Click and drag to adjust the axial direction of the selected tooth. 

 

3.4 Horizontally Flipping Axis 

View a 2D image such as Axial, Sagittal, Coronal or Section View flipping horizontally based on 

the axis. 

1. Right click on the desired view and select the [View Flip]. 

 

 

▪ Flipping the image horizontally changes the direction of slices. 

▪ The [Reset View] function does not apply on the state. Use the [Initialize All] 

function to initialize all including the image direction. 
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4. Changing Layout 

The user can change the location and configuration of the images that appear in the 
Workspace. 

1. Click the [Change Layout] button on the bottom left. The [Change Layout] window appears. 

2. Click the layout to set as the default layout, and then right click the selected layout. 

 

3. Click the [Set Default Layout] button to set it as a default layout and then click the [Ok] 
button. The Workspace configuration has changed to the selected layout. 
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5. Switching to Presentation Mode 

3D, Axial, Sagittal, and Coronal images are displayed on one screen. 

1. Click the [Change Layout] button. The [Change Layout] window appears. 

2. Click the [Presentation Mode Start] button on the bottom left. The Full Screen Mode window 
appears. 

 

 

>> Presentation Mode 
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 A large image is displayed on the monitor to be utilized during patient consultation. After 

selecting an image, change it to Full Screen Mode via the keyboard shortcut 

<Ctrl>+<Enter>. 

 Right click the image and select the [Presentation Mode (On)] option to view in the 

Presentation mode. 

 

3. The hidden Toolbar reappears when the mouse is placed over the arrow on the left. 

 

4. Click the exit button on the upper right-hand corner to close the Presentation mode. 
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5.1 View Image in Full Screen Mode 

1. Double-click on the title of the image in the upper-left corner (axial, sagittal, or coronal). The 
selected image will be viewed in the full screen. 

 

2. Double click the image tile in Full Screen Mode to return it to the previous layout. 

 

 

Utilizing the <Enter> key on the keyboard: 

Click the Window Title and press the <Enter> key on the keyboard to maximize the selected 
window. 

To return the window to its previous size, press the <Enter> key on the keyboard in the 
maximized window. 
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6. Help 

Click Help( ) from the toolbar. The user can find the User Manual of Ez3D-I in CHM file format. 
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7. Toolbar 

Click the icons on the toolbar of each tab to execute the function. Press the <Esc> key on the 

keyboard, click the icon again, or right click on the image to cancel the function. 

 

 

 

 

The following functions cannot be canceled with the <Esc> key or with a mouse right click. 

Icons Designation Icons Designation 

 
Reset View 

 
Initialize All 

 
Undo 

 
Turn Overlay On/Off 

 
Redo 

 
Show Manager 

 
Reset 

 
Delete All 

 
Pointer 
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8. Shortcut Keys 

The following table describes the shortcut keys for general view of images. 

Category Action Operation 

Window 
(General) 

Double click the title of each window. 
Single View window 

Return to the previous layout. 

Hover the mouse over each window. View focused. 

Press <Enter> key. 
Single View window 

Return to the previous layout. 

Press <Ctrl + Enter> key. Presentation Mode On/Off 

3D View 
Window 

Scroll the mouse wheel. Zooming 

Click + Drag and Drop. Rotation 

Right click + Drag and Drop Panning 

Double click. Smart Zoom 

Press space bar on the keyboard. Show / Hide 3D Axis 

2D View 
Window 
(MPR tab) 

Press <Ctrl> key + scroll the mouse wheel. Zooming 

<Shift> key + Right click + Drag and Drop Panning 

Scroll the mouse wheel. Change interval. 

Right click + Drag (left or right) + Drop Adjust the width (brightness). 

Right click + Drag (up or down) + Drop Adjust the level (contrast). 

Press space bar on the keyboard. Show / Hide 2D Axis 

Double click. Move the center of axis to point clicked. 

Window 
(Section tab) 

Double click the title of Section window. 
Maximize Section window. 

Return to the previous layout. 

Double click the Section View image. 
Maximize Section window (1X1 size). 

Return to the previous layout. 
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Chapter 4. MPR Tab 
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1. MPR Tab Configuration 

MPR (Multi Planar Reconstruction) tab provides a user-determined cross-sectional view. 

Ez3D-i provides 3D VR (Volume Rendering) images as well as Axial, Sagittal, and Coronal 
images: a cross sectional image from the vertical, lateral and frontal point of view. 

1.1 Workspace 

 

▪ A: MPR Tab used to diagnose general images. 

▪ B: Tools used in MPR tab. 

▪ C: Control Panel with frequently used function in MPR Tab. 

▪ D: View frame where the image is displayed in various view mode. 

 3D Image Info 
On the bottom at the right corner of 3D view, the FOV of the CT image and the center 
point of three axes are shown on the MPR view. 

 2D Image Info 
On the bottom at the right corner of 2D images, the thickness, interval, Slice Number 
(Current Slice/Total Slice) of the image are shown on the MPR view. 

 Properties of Axial, Sagittal, Coronal plane 

 

 

On the Axial, Sagittal, and Coronal view, press the space bar on the keyboard to turn on or off 
the axes. 

A 
B 

C D 
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1.2 Menu Button Properties 

 

▪ A is the main button. From here, users can load or save files and change the default 
settings of the program. 

▪ B is the main toolbar. The main tools are configured identically on all tabs. 

▪ C is the expansion toolbar. The expansion tools are configured differently depending 
on the tab selected by the user. 

▪ D is the window button. It is composed of minimize, maximize and close screen 
buttons. 

  

A 
C 

D 

B 
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1.3 Control Panel 

    

Control panel consists of important functions that manipulate the View. It is configured differently 
depending on the tab selected by the user. 

No. Name Description 

1 SIMULATION Group Group of buttons to execute functions such as drawing curves, 
inserting implant, extracting tooth, and measuring Airway. 

2 MODE Group Group of buttons to execute functions such as making Oblique plane 
and conducting Superimposition. 

3 VR COLORING Group Function to set the Rendering Mode, opacity, brightness, and contrast 
of data displayed in the 3D View 

4 WINDOWING Group Function to adjust the Width / Level value and to set the image effect 
of 2D images 

5 CLIPPING Group Function to check the 3D Image by clipping the image in various 
direction 

6 Change Layout Button Button to change the layout of View Frame 

 

 

  

2 

1 

3 

 

 

4 

5 

6 
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2. Changing 3D Rendering Mode 

2.1 VR Coloring 

The image coloring is optimized with the rendering value that the user has chosen. 

1. The preset rendering values are as follows: Tooth, Bone, MIP, Soft Tissue, Soft Tissue 2, 
and VR Coloring. 

2. Control the VR coloring icons to change the 3D VR values and to make fine adjustment to 
the values. 

3. The opacity, brightness and contrast of the image can be adjusted by moving the slider to 
the left or right. 

▪ Pre-set coloring mode 

Click an icon among the following icons with pre-set value for VR coloring function. The 
screen will display the image according to the selected mode. 

Icons Designation Description of Functions 

 
Teeth Tooth mode view 

 
Bone Bone mode view 

 
MIP MIP mode view 

 
Soft Tissue Soft Tissue mode view 

 
Soft Tissue 2 View Soft Tissue with low transparency 

 
VR Coloring View the VR coloring graph panel 
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2.2 Fine Tuning The VR 

3D volume VR is adjusted and optimized by utilizing one of the preset options: Teeth, Bone, 
MIP, Soft Tissue, and Soft Tissue 2 mode. The opacity, brightness, and contrast of 3D volume 
VR can be adjusted by clicking the VR Coloring icon. 

1. Select one of VR Coloring modes to tune VR finely. 

  

2. Select the VR Coloring icon as follows. 

  

3. The Volume Coloring graph appears in the following screen. 

  

4. Click the opacity, color point on the graph and drag it to the desired point to adjust the VR 
Coloring. The adjusted coloring value appears on the screen in real time. 

 

5. To move the whole graph line, click and drag the graph area as follows; by doing so, the 
value of VR Coloring is changed. 

 

6. To initialize all changes, click [Reset] button. 
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With the [Default Setting] button, users can set up the default value in various 
modes. 

2.3 Adding and Deleting VR Coloring Graph 

When 2 or more adjusted value is required to view, for instance, soft tissue and bone at the 
same time, the user can add VR coloring graphs to view the image optimized for each 
requirement. 

 

For a CT image that has a project saved from a previous version of Ez3D-i, initialize the 
graph before adding an additional VR coloring graph. 

1. Right click on the outside of existing VR coloring graph then the context menu appears. 

 

2. Click [Add Graph] to add a VR coloring graph. The maximum number of graphs is 3. 

       

3. Right click on the graph to delete and select [Delete Graph] from the context menu to delete 
the graph. At least 1 VR coloring graph must exist. 

 

2.4 Editing the Volume Coloring Graph 

The Volume Coloring graph can be edited by adding and deleting an opacity point, or a color 
point. The transparency, brightness and contrast of VR can also be adjusted, optimizing each 
diagnosis. 

▪ Add Opacity Point  

1. Right-Click on the Volume Coloring graph. The following list appears: 

 

2. Click [Add Opacity Point], then a new point is added on the graph as shown in the following 
screen: 
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▪ [Add Color Point] 

1. Right-click on the desired color area in the above of Volume Coloring graph. 

 

2. Click [Add Color Point]. 

 

3. A new Color Point is added, as shown here: 

 

 

 

▪ Delete Opacity Point  

1. Right-click on a point on the graph 

 

2. Click [Delete the Point] button to delete 

 

▪ Delete Color Point  

1. Right-click a point on the color area 

 

2. Click [Delete the Point] button to delete 
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2.5 Controlling VR Coloring Mode 

While viewing the image in the VR coloring mode, user can move the slider to adjust the display 
if necessary. 

 
Opacity Adjust the transparency of 3D image. 

 
Brightness Adjust the brightness of 3D image. 

 
Contrast Adjust the contract of 3D image. 

 
Reset 

Initialize the filtering setting values except for 
the VR Coloring mode. 
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3. Adjusting 2D images 

By adjusting the brightness and contrast levels of a 2D image, the user can optimize their image 
for accurate diagnosis. To adjust the brightness and contrast of the 2D image, move the slider to 
the left or right. Or right-click on the image and drag to manipulate the brightness and contrast 
value. 

▪ WINDOWING Icons 

Icons Designation Description of Functions 

 
Width Adjust the brightness of the image 

 
Level Adjust the contrast of the image 

 
Smooth Make the image smooth 

 MIP 
Reduce the burring area of metal and make the 
image clearer (MIP: Maximum Intensity Projection) 

 Sharpen Sharpen the edge of image 

 Max Sharper Sharpen the edge of image to its maximum level 

 Inverse Inverse of black and white 

 VR 
Check the image in VR mode. 2D VR mode is 
applied the same with the selected 3D VR mode 
(Teeth, Bone, MIP, Soft Tissue, Soft Tissue 2).  

 
Windowing 

Graph 
Use the graph to adjust Windowing value. 

 
Reset Initialize all effect applied on images. 

▪ Comparison of the 2D image brightness [Width] 
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▪ Comparison of 2D image contrast [Level] 

      

 

▪ Comparison of the 2D image inverse [Inverse] 
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4. Clipping 

Clipping cuts a 3D image in an axial direction and shows the cross-sectional view. 

The Clipping function can be done by using the slider bar or a user can set the thickness and 
position of the image slice. 

4.1 Clipping By Specifying Position 

1. Click the [Apply Clipping] button to start clipping. 

 

2. Select the axis of the ball by deleting the volume of the 3D images on the clipping window. 

 

3. Slide the bar to the left and right to clip the image in the direction of the corresponding axis. 

 

4. The 3D image cut is displayed as follows. 
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5. Click the [Reset Clipping] to reset the image to the original condition. 

 Example of Clipping Image 

       

     <Coronal>            <Sagittal>                <Axial> 

 Clipping direction depending on the corresponding axis 

 

 When the coronal axis is selected, the slider bar setting is changed to A→P. 

 When the axial axis is selected, the slider bar setting is changed to F→H. 

 When the sagittal axis is selected, the slider bar setting is changed to R→L. 

 

4.2 Clipping By Choosing Thickness 

1. Click the box for the slice thickness selection. 

 

2. After selecting the size of the thickness, control the location and thickness of clipping with 
the slider bar. 
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3. The 3D image is chopped as shown in the following screen. 

 User Clipping 

   

 
  

 Thickness Clipping: 10mm 

   

  
 

4. Click [Reset Clipping] to return to the original image. 

 

4.3 Smart Clipping 

Smart Clipping allows user to view the clipping result on the 3D image view. 

1. Click Smart Clipping in the box as shown here: 

 

2. Control the location of clipping on the slider bar. 
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3. 3D image clipping is shown in the following screen. 

 

4. Click [Reset Clipping] to return to the original image. 

▪ Image Icons 

Icons Designation Description of Functions 

 Coronal Clipping 
Crop image front and back around the Coronal 
axis. 

 
Sagittal Clipping 

Crop image front and back around the Sagittal 
axis. 

 Axial Clipping 
Crop image front and back around the Axial 
axis. 

 Smart Clipping Crop image front and back around the Z axis. 

 
Clipping Slider Set the area to crop. 

 
Clipping Combo box Set the thickness to delete the image volume. 

 
Reset Clipping Reset Clipping 
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5. Measuring 

The user can measure the length, angle, volume and also see the bone density profile using our 
basic measuring tools. The measured length, angle, volume can be hidden or deleted on the 
screen. Also, the user can change the properties of the measured line. 

5.1 Measuring Length 

5.1.1 Measuring Length on 2D Image 

1. Click [Length] icon to measure the length as below. 

 

2. Click two points to measure the length. Then the numerical value appears on the screen. 

 

3. Click [Length] icon again or right-click the image to finish measuring. 

5.1.2 Measuring Length on 3D Image 

1. Click [Length] icon to measure the length as below. 

 

2. Click two points to measure the length. Then the numerical value appears on the screen. 

 

3. Click [Length] icon again or right-click the image to finish measuring. 



Chapter 4. MPR Tab  
 

114 Ez3D-i User Manual 

4. The measured length can be controlled by selecting or deselecting the check boxes under 
the [Show/Hide Manager > Measurement] menu. 

 

 

5.2 Measuring Multi length 

1. Click the [MultiLength] icon on the toolbar. 

 

2. Click all points to measure length on the 2D image. The measured length is displayed as 
shown in the following figure. 

 

3. Double click on the last point to stop measuring. 

4. Click the [Multi Length] icon again or right click on the image to measuring 

5. After measuring length or angle, user can change its property. 

▪ Property 

 After measuring length or angle, the user can change the property of them by right 
clicking directly on the measurement line. Select [Property] button. 

 Here you can change the line color. One done, click the [OK] button. 

▪ Hiding and Deleting 

 After measuring length or angle, select the [Hide] or [Delete] button. Then, select 
your desired action. 
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5.3 Measuring Angles 

1. Click [Angle] icon to measure the angle as shown below: 

 

2. Click three points to measure the angle. Then the numerical value appears on the screen. 

 

3. Click [Angle] icon again or right-click the image to finish measuring. 

 

5.4 Measuring Multi Angle 

1. Click [Multi Angle] icon to measure multi angle as shown below: 

 

2. Click all points to measure angles in a row in 2D Image View. 

 

3. Values are displayed where angles are made.’ 

4. Double click the last input point to complete measurement or hit Enter key in keyboard. 
Then, valid multi-angles are inserted to the last inserted point. 

5. Right click the inserted multi-angle overlay to display context menu.  

 

6. The user can view property of the overlay, and hide or delete the overlay by using Property, 
Hide, and Delete menu.  
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5.5 Measuring Circle Radius 

1. Click [Circle Measure] icon to measure radius of circle as shown below: 

 

2. Click the first point at desired position to measure in 2D image View. 

 

3. Drag the mouse to adjust circle size, then second point of the circle follows the mouse 
pointer. 

 

4. Click the position where to stop measurement to complete circle measurement. 

5. The measured value is displayed in billboard format, and the circle is displayed in solid line. 

 

6. Select the inserted circle overlay by right-clicking to display context menu. 

7. The user can view property of the overlay, and hide or delete the overlay by using Property, 
Hide, and Delete menu. 
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5.6 Profile 

1. Click [Profile] icon to see the bone density as shown below: 

 

2. Click two points to see the bone density value based on your 2D image. 

 

3. The Profile window appears. This profile graph shows the bone density between two points. 
Move the mouse on the profile line and control the area. The maximum, minimum, and the 
average value change in real time based on the selected area. 

 

 

There are many cases where CBCT has different CT Number values, which are the standard 
of bone density standard, depending on the equipment. 

Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

 Capture Profile 

Click the [Profile Capture] button at the bottom left of the window to capture the Profile 
Dialog and Profile Object. 

1. Click the [Profile Capture] button. The mouse cursor changes to capture mode. 

2. Drag the mouse to select desired region then the [Capture] button appears. Click the capture 
button to capture the selected region. 
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5.7 ROI 

1. Click ROI button to get the information of pixel, average value, maximum value and 
standard deviation. 

 

2. By selecting ROI in a 2D image, users can check the information on that area. 

 

 Changing the ROI box size 

 

Place the mouse cursor at the edge of the ROI box. The controller appears. While 
pressing the left button of the mouse, drag the box to change the size. The ROI 
information changes accordingly. 

The box size cannot be adjusted using a keyboard. 

 Left/right/top/bottom: The size of box changes in the direction selected according 
to amount of the mouse movement. 

 Diagonal: The size of box changes with a fixed ratio according to the amount of the 
mouse movement. 
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 Moving the ROI box 

 

Place the mouse cursor at the edge of the ROI box. The cursor changes to move the 
location. While pressing the left button of the mouse, drag the box to the new location. 

 Deleting and hiding the ROI box 

 

Right click the ROI box to delete or hide the box. 

 

5.8 Measuring Volume 

1. Click the [Volume] icon to measure the volume as shown below. 

 

 

The volume cannot be measured when the image is sculpted. 

2. The volume of the selected area will be measured. 
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3. The Volume Measure window appears, and the numerical value of volume is shown. On 
this window, the user can change the volume color and adjust the opacity and the intensity. 

If the intensity is changed, only the volume of the selected area according to the adjusted 
intensity will be calculated. 

 

 

▪ Region Capture  

Click the [Region Capture] button to capture the volume with the Volume Measure 
dialog. 

1. Click the [Region Capture] button then the mouse icon changes to the capture 
mode.  

2. Drag the mouse to set the region to capture then the [Capture] button 
appears. Click the [Capture] button to capture the selected region. 

 

4. The user can edit Axis and ROI as well as change slice. By selecting the [Sync with axis] 
check box, ROI volume and MPR axis are synchronized. The default value is deselecting. 
Volume is measured as follows by selecting/deselecting the checkbox. 

[Sync with axis] Selected [Sync with axis] Deselected 

▪ Moving ROI: 

Move or rotate MPR axis or drag and drop 
volume measurement ROI to move the 
volume. 

 

 

 

▪ Moving ROI: 

Drag and drop volume measurement ROI to 
move the volume. 
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▪ Changing ROI size: 

Drag and drop control points of ROI to resize 
the ROI. 

 

▪ Changing Interval: 

The function is disabled. 

▪ Changing ROI size: 

Drag and drop control points of ROI to resize 
the ROI. 

 

▪ Changing Interval: 

Scroll the mouse wheel on a 2D view to 
change its slice. 

 

5. Click the [OK] button, and the volume is displayed on the 3D and 2D screens as below. 

 

6. The user can delete the displayed volume on the 3D and 2D screen. 

Right click the volume box on the 2D image and then the following list appears on the 
screen. 

 

Click the [Delete] menu to delete the volume from the screen. 
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6. Capture 

Use the capture icons on the tool bar to capture the selected area, the selected window or multi 
images. 

6.1 Capture the Selected Area 

1. To capture the selected area, click the [Capture Region] icon. 

 

2. Click the area and the [Capture] button appears. Check the area and click the [Capture] 
button. 

 

3. The following window appears, and the image is saved. 
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6.2 Capture Selected Window 

1. To capture the selected window, click the [Capture Window] icon. 

 

2. Click to activate the window to capture. On the 3D viewer, click the [Capture] button, and on 
the Axial, Sagittal, or Coronal viewer, click the [Capture (With Overlay)] button or the 
[Capture (Without Overlay)] button to capture. 

 

3. The following window appears, and the image is saved. 

 

6.3 Multi Capture 

1. Click [Multi Capture] button to capture the images continuously. Multi captured images 
cannot be sent to 2D Viewer such as EzDent-i. 

 

2. Select the window (Axial, Sagittal, Coronal) to capture. Select Capture with overlay or 
Capture without overlay. [With Overlay] captures the image with overlay user has done. 
[Without Overlay] captures only the image. 

 

 

The 'Capture (Without Overlay)' button is not shown when secondary CT data exists. Only 
'Capture (with overly)' is available with superimposition data. 
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3. Select the area of the image to capture in the [Multi Capture] window. The [Interval] and 
[Thickness] options can be only changed when the [Without Overlay] is selected. 

 

 Image Area: Users can check the range of the image.  

 Interval: Users can set the interval of the image. 

 Thickness: Users can set the thickness of the image.  

 Image Slice: Users can see the number of slice images.  

 Image Preview: Users can preview the first and last sliced images. 

4. Click the [OK] button to complete the multi capture. 

 

6.4 Movie Capturing Program 

If the Create Movie Clip is selected in the [MAIN MENU > Settings > Environment > Linkage/E-
Mail > Linkage Software for Toolbar] menu, user can run the movie capturing program. 

Click the [Create Movie] icon on the toolbar. The movie capturing program saved in the Settings 
will be launched. 
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7. Drawing Canal 

7.1 Drawing Canal 

1. Click the [Draw Canal] icon on the tool bar. The mouse cursor changes to the drawing 
mode. 

 

2. To draw the canal line, click points along the mandibular nerve on a 2D or 3D image. Also, 
existing canals on a 2D or 3D image can be extended. 

 

 

▪ The drawing method is the same on the 2D and 3D viewers, but on 3D viewer, 
clipping and sculpting precede drawing canal. 

▪ Right click while drawing the canal line to delete the previously plotted input point. 

▪ Keyboard shortcuts for Canal Drawing (Available only when the Canal Drawing 
function is on) 

 Volume Rotation: Ctrl + Right Click + Drag 

 Panning: Shift + Right Click + Drag 

 Zooming: Ctrl + Mouse wheel 
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3. Double click to complete the canal line. 

 

 

▪ The completion of canal line can be verified after all points are connected. 

▪ Clicking the [Draw Canal] icon while drawing the canal line will cancel the Draw 
Canal function. The function can also be canceled by pressing the <Esc> key on 
the keyboard. 

▪ The canal drawn is displayed on all tabs, and particularly it appears the same in the 
3D VR coloring mode. 

7.2 Editing Canal 

1. Right click on the inserted canal the following context menu appears. 

 

2. Click the [Edit Canal] menu. The inserted canal points and the line connecting the points 
appear on the 3D image, and the canal points appear on the 2D image. 

 

 Right click on the line connecting the canal point to add points. 

 

 Right click on the canal point to delete points.  
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3. Right click on the canal and click the [Exit Editing Mode] menu after editing the canal. 

 

4. There appears a message asking, “Apply changes made to canal point?”  

 

5. Press the [OK] button, the new canal points will be applied to the canal. 

 

 

7.3 Changing Properties of Canal 

1. Select the canal line and click the right mouse button. The following list appears. 

 

2. Click [Property] and the [Canal Property] window appears. 

 

3. Click the [Canal Diameter] dropdown menu to select the diameter of the c 

4. anal line. Click [Canal Color] and select the color of the canal line. 

5. Click the [OK] button and the changes are reflected in the canal line.  

 

▪ The image can be moved, zoomed in or out only using the shortcut keys while 
editing canal. 

▪ When the canal point is selected on the 3D image, the MPR axis is adjusted 
automatically to display the sectional image where the corresponding point is 
inserted. 

▪ User can only add or delete the canal points on the 3D image. 

▪ User can only move or delete the canal points on the 2D image. 

▪ Double click to end the canal edit mode. 
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7.4 Hiding or Deleting Canal 

Select the canal line and click the right mouse button. The following list appears. 

▪ Click [Hide] and the canal line disappears from the screen. 

 

▪ Click [Delete] to delete the selected canal line. 

 

 

1. Click the [Show Manager] icon. The [Show/Hide Manager] window appears. 

 

2. Uncheck a box to hide the object/canal drawing/measurement. Click the [OK] 
button and the selected canal line disappears from the screen. 
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8. Drawing Curve 

Draw Curve function is to insert a curve line according to the clinical points on MPR image and 
to check the consecutive images perpendicular to the inserted curve Line. 

To draw a curve: 

1. Click the [Draw Curve] button 

 

2. Click on clinical point on the MPR Sectional image to insert curve point. The inserted curve 
point automatically makes an overlay, which forms a curve. Right click while drawing the 
canal line to delete the previously plotted input point. 

3. Double click the left mouse button to finish drawing curve. When the drawing is completed, 
the screen will be switched to Section tab and the curve will be added to Curve List. 

 

 

To cancel the drawing, press the <Esc> key on the keyboard. The curve will be deleted. 
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9. Implant Simulation 

Implant can be inserted with Insert Implant button including Smart, Axis, Click Point options, or 
by measuring length of a certain tooth. 

▪ Smart Placement: An implant/ implants will be inserted into the tooth position matching the 
selected tooth codes automatically. 

▪ Axis Placement: An implant will be inserted on the axis automatically. 

▪ Click Point Placement: The mouse cursor will change to the insertion mode and an implant/ 
implants will be inserted at the point where the mouse is clicked. 

▪ Implant Placement by Measuring Length: Regardless of the [Placement] option, an implant 
can be inserted after measuring the length of the tooth. 

9.1 Inserting Implant 

1. Click the [Insert Implant] button. 

  

2. The [Implant Property] dialog appears. 

  

3. Select the Single option to insert only one implant or Mutiple option to insert two or more 
implants in a row. 

 

4. Click the tooth code to insert. 
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5. The default implant properties for the selected tooth number is shown as follows. Select the 
desired implant company, line-up and model from the list. 

  

 

Press the [Set as default] button to set the selected implant as the default for the tooth 
number. The default implant value can be modified in the [Settings > Simulation > Implant]. 

6. Select Implant options to insert Implant (with/without Guide and/or Path) or Crwon. 

 

* Please refer to ‘Chapter 4. MPR Tab > 9.1.2. Implant Placement Option: Axis’ to see the 
result image according to the different selection of Implant, Guide, Path and Crown options. 

7. If you choose Multiple option, repeat from 4 to 6 until you select all tooth codes to insert. 

  

8. Select the Placement option between Smart, Axis, Click Point and click the [Insert] button 
for implant simulation. 

* Please refer to the following ‘Chapter 4. MPR Tab > 9.1.1 Implant Placement Option: 
Smart, 9.1.2 Implant Placement Option: Axis and 9.1.3 Implant Placement Option: Click 
Point’ to learn the result of Smart, Axis, Click Point placement. 

9. Click the [Insert] button then the implant will be shown on the image.  
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10. After inserting an implant, click the implant and drag, or double click the implant and use 
the controller to adjust the implant position. 

 

9.1.1 Implant Placement Option: Smart 

An implant will be inserted automatically if the [Placement] option is set to [Smart]. 

 

Please note that the Smart placement is available only when there exists a segmented 
DATA. Please complete tooth segmentation on the SEGMENT Tab before using this option. 

1. Click the [Insert Implant] button. 

2. Select the tooth number and implant information on the [Implant Property] window. 

  

3. The selected Implant is inserted automatically into the tooth position that matches the 

selected tooth code. 
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9.1.2 Implant Placement Option: Axis 

 

Please note that Axis placement only supports Single implant placement. The Axis option will 
be disabled when selecting Multiple option. 

An implant will be inserted at the center of the axis if the [Placement] Option is set to [Axis]. 

1. Double click the tooth to place an implant. The screen will automatically rotate and zoom 
the image to display the selected tooth on the axis. 

           

2. Click the [Insert Implant] button. 

3. Select the tooth number and implant information on the [Implant Property] window.  

  

4. Click the [Insert] button, then the selected implant will be inserted at the center of the axis. 

 Options Result Image 

Implant 
Only 
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Implant 
& Crown 

 

 

 

Crown 
Only 

 

 

 

Implant 
with 

Guide & 
Path 
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9.1.3 Implant Placement Option: Click Point 

An implant will be inserted at the selected point of the image if the [Placement] option is set to 
[Click Point]. 

1. Click the [Insert Implant] button. 

2. Select the tooth number and implant information on the [Implant Property] window. 

  

3. The list of selected implants is displayed to show the current implant placement status of all 
selected tooth codes. 

  

4. Click the position to insert an implant on the image. 

5. The inserted implant is shown on the image. 

 

6. Click the points to insert rest of the implants on the list. 
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9.1.4 Implant Insertion by Measuring Length 

1. Click the [Length] icon on the toolbar to measure 2D length. 

2. Click the measured length on the image. Right click it and select the [Insert Implant] menu. 
It will display recommended implant options that are similar to the measurement. 

 

 

The implant options are selected from the implant list for each tooth that are set in the 
[Settings > Simulation > Implant]. 

3. Click the proper implant and it will be inserted. 

After inserting an implant, right click to delete or hide the implant or to change its properties. 
If the implant is deleted on the 3D image, it will also be deleted on the 2D image. 

 

9.2 Editing Implant 

9.2.1 Copying and Pasting Implant 

1. Right click on the inserted implant to open the context menu. 

2. Click the [Copy Implant] option to copy the selected implant. 

 

 

The Tooth Code is not included in the copied implant information. 

Enter or edit the Tooth Code in the Property menu of the copied implant. 

 

3. Right click on the point where you want to insert implant to open the context menu. 

4. Click the [Paste Implant] option. The copied implant is inserted. 
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9.2.2 Editing Implant 

1. Right click on the inserted implant to open the context menu. 

2. Click the [Edit Implant] option. 

3. Use the + / - button to edit the Length, Occlusal, and Apical information. 

 

 The Company and the Model (line-up) can be modified if they are applied from the 
same company and the model group. 

 Occlusal Diameter can be only adjusted to the width that the currently selected 
Length supports. 

 Apical Diameter can be only adjusted to the width that the currently selected 
Occlusal Diameter supports. 
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9.2.3 Editing Crown 

1. Right click on the crown of the inserted implant to open the context menu. 

2. Click the [Edit Crown] option. 

3. Use the + / - button to edit the Mesial/Distal, Lingual/Buccal, and Height information. in the 
[Edit Crown] window. 
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9.2.4 Editing Implant Guide & Path 

1. Right click on the inserted implant guide and/or implant path. 

 

2. Select the [Edit Guide & Path] option. 

  

3. The [Edit Guide & Path] window appears. Change the values in the [Implant Guide] and 
[Implant Path] option on the dialog. 

 

 

An error message appears when values out of range are inserted. 

4. After setting the values, press the [OK] button to apply changed values [Cancel] button to 
restore the original values. 
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9.3 Moving, Rotating and Locking Implant 

9.3.1 Moving ,Rotating and Locking 3D image 

The inserted implant can be moved on the 3D image. The selected implant moves horizontally 
with the direction of the current 3D image. 

Double click or right click on the implant to show the controller. Click and drag the arrow of the 
controller to move or rotate the implant as desired. 

  

Implant Controller Crown Controller 

▪ Moving 

 Click one of the six arrows. The color of the selected arrow changes. 

 

 Move with the up/down arrow keys on the keyboard: down arrow key moves to the left 
by -0.1mm and the up-arrow key moves to the right by +0.1mm. 

 Click the other arrows or rotation controller to cancel the selection. 

▪ Rotating 

 Click one of the three rotation controllers. The color of the selected controller changes. 
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 Move with the up/down arrow keys on the keyboard: up arrow key turns it clockwise by 
one degree and the down arrow key turns it counterclockwise by one degree. 

 Click the other arrows or rotation controller to cancel the selection. Click the other 
arrows or rotation controller to cancel the selection. 

▪ Locking/ Unlocking 

 Right click on the implant and select the [Lock] option to fix the location of the implant. 

 Right click on the crown and select the [Lock] option to fix the location of the 
crown. 

 An implant guide and/ or implant path follows the attribute of the implant 
regarding the Lock/ Unlock option. 

 Right click on the locked implant and select [Unlock] option to change the location of 
the implant.  
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9.3.2 Moving, Rotating and Locking 2D image 

After choosing the implant from a 2D image, a control line is created to rotate the implant. Click 
and drag a point to move and rotate the implant. 

 

Click on the implant. When the mouse cursor changes to the cross , the implant can be 

moved. And when the mouse cursor changes to the curved arrow , the implant can be 
rotated. 

 

Right click on the implant and select the [Lock] option to fix the location of the inserted implant 
on 2D images as well as 3D images. 

9.4 Showing and Hiding Implant 

1. Right click on the inserted implant, crown, or implant guide & path. 

 

2. Select the [Hide] option. 

3. The selected implant, crown or Implant guide & path will not be displayed in the view. 
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10. Extract Tooth 

Extract Tooth function is to simulate tooth extraction before conducting implant simulation or 
orthognathic simulation on the 3D View. As tooth extraction is required in many treatment cases, 
this function enables users to simulate under the condition similar to the real environment. 

This function is available only when there exists segmented data. Please complete tooth 
segmentation or import segmentation data on the SEGMENT Tab before using this function. 

1. Click the [Extract Tooth] Button in the SIMULATION group. 

 

2. The [Extraction] dialog appears, and segmented tooth objects are displayed on the 3D 
View. 

  

3. Click the number buttons of teeth to extract and press the [OK] button. 

  

4. The selected teeth are not shown on the image. 
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11. Airway Measurement 

 

The Airway measurement may have incorrect error range and values depending on the 
CBCT equipment value. 

Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

The Airway Measurement function measures the airway volume of the clinical point. 

11.1 Measuring Airway 

1. Click the [Measure Airway] to start the Airway measurement function. 

 

2. The 3D and Sagittal images change to select the Airway position for measuring as shown in 
the following figure. 
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3. When the mouse pointer changes into ‘ , click on the starting and the ending points of the 
airway to measure. 

 

▪ Click the two points that are included in the Airway, regardless of the inputting order, to 
create a straight path. 

▪ Use the mouse wheel to change the interval on the Sagittal View, and the points can be 
inserted only on the Sagittal View. 

4. After inputting the starting and the ending points, the Airway volume is created according to 
the predefined Intensity in the Settings, and the Airway Measurement function is 
terminated. 

 

 

▪ The Airway function cannot be applied in the layouts where 3D Volume is not 
included. 

▪ The interval cannot be changed while inputting Airway points. 

▪ The layout returns to the previous layout when the Airway Measurement function is 
terminated, but the MPR axis does not go back to how it was before the 
measurement. 
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11.2 Displaying Airway 

The measured Airway is displayed in different colors depending on the area, and the Gradient 
Bar, which guides the color by Airway area, is also shown with the Airway. 

The total volume (㏄) and the area (㎟) of the smallest area among the cross sectional areas are 

also displayed in the measured Airway volume. 

 

▪ The color for the six points can be changed in the [MAINMENU > Settings > Simulation > 
Airway] menu. 

▪ The measured airway is displayed on the 2D images as a form of outline so that the user 
can check the cross-sectional areas of each axis. 

▪ The Airway Volume is not displayed on the CT data when opening the CT data with the 
results of the Airway Measurement. Click the checkmark of the Airway option in the VR 
Coloring Group to display the Airway. 

  

▪ The progress window appears when recalculating the Airway. When there is no result of 
Airway measurement, the checkbox of the Airway option in the VR Coloring Group is 
disabled. 
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11.3 Viewing Sectional information of Airway 

1. Right click on the measured airway to open the context menu. 

 

2. Click the [Measurement Plane] option. The pop-up window appears to measure the 
sectional Airway on the Axial view. 

 

▪ Use the mouse wheel to change the interval, and the airway of the corresponding Axial 
view is displayed on the sectional image. 

▪ The sum of all area is displayed if the Airway area is not connected and shown 
disconnected. 

▪ The default image of the pop-up window is the corresponding Axial view for the 
minimum cores-sectional airway. 

▪ Click the [Region Capture] button to capture the pop-up window and the selected area 
in the View screen. 

▪ While the [Measurement Plane] window is on, the user can control 2D and 3D images 
on the View and use short cut keys including <Ctrl> key. 
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11.4 Airway Properties 

1. Right click on the measured airway to open the context menu. 

 

2. Click the [Property] option. The pop-up window appears to change the properties of the 
measured airway. 

 

▪ Prevent Leak 

Set the default value for the function that removes the areas, which are not part of the 
Airway. 

▪ Sensitivity 

To adjust the degree of the Prevent Leak function, click the dropdown menu of the 
[Prevent Leak] to select the [Use Correlation Method] option.  

▪ Maximum Airway ROI Width 

Click the starting point and the ending point of the Airway to measure and a square 
(ROI) will be created based on the center point of the two selected points. The Airway is 
measured within the square (ROI). 

Change the number of Maximum Airway ROI Width to widen or reduce the Airway area. 
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12. Oblique 

Oblique function is to create the Plane on the MPR 2D View based on the selected point by user 
and to check images by rotating images based on the Center point of the Plane. 

12.1 Drawing Oblique Plane 

1. Click the [Oblique] Button to execute the Oblique Plane Drawing function. 

 

2. Click the Center point of Oblique Axis on the MPR View. 

 

▪ Based on the Oblique Center point, the Oblique Line and the Oblique Guide Point are 
created. 

▪ Based on the created Oblique Line, the MPR Axis is updated and the rotating Oblique 
View is created based on the Oblique Line. 

▪ The 3D View Window is switched to display the Oblique View and the relevant image is 
displayed according to the Oblique Line. 

 The axis can be controlled only on the view where the Oblique is inserted. 

 Scroll the mouse wheel to zoom in or out the image on the Oblique View. 

 The interval cannot be changed on the Oblique View 

3. Click the Oblique button again to close the Oblique view and the Oblique Plane will not be 
saved. 
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12.2 Editing Oblique Axis 

User can move or rotate the Oblique Line to check the images. When user clicks the Oblique 
Line to select or place a mouse over the Oblique line, the direction of image is displayed as 
cursor. 

▪ Center Point Translation 

Click and then drag and drop the Oblique Center Point to move the whole Oblique Axis to a 
different location. 

 

▪ Oblique Line Panning 

Click and then drag and drop the area inside the Oblique Guide Point (not the Oblique 
Center Picking points) to pan the image along the MPR Axis. 

 

▪ Oblique Rotation 

Click and then drag and drop the area outside of Oblique Guide Point to rotate on Oblique 
Center. 

 

 When placing a mouse over the Center Point Picking Area, the Translation Guide 
Overlay is displayed. 
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 When placing a mouse over the Oblique Line Panning Area, the Panning Guide 
Overlay is displayed. 

▪ Enlarging Oblique Image 

Click and drag the Oblique Guide Point to enlarge or reduce the Oblique image based on 
the Oblique Center point. 
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13. Superimposition 

Superimposition function is to compare primary CT and secondary CT by overlapping the two CT 

image on the same view. After adding the before/ after surgery image of a patient as primary CT 

and secondary CT in the same Data group, the user can use Superimposition function to compare 

the original image with the after surgery image. 

1. If there exists no secondary CT image on the Data group, import a secondary CT file. 

 

Please refer to the ‘Chapter 1. Ez3D-i Basics > 5.7.3 Import Secondary CT’ for more 
information about import process. 

2. If secondary CT is not registered, register the secondary CT data.  

 

Please refer to the ‘Chapter 4. MPR Tab > 19.2 Data Registration’ for more information 
about registration process. 

3. After registration, click the [Superimposition] Button in the MODE group to view the 
overlapped secondary CT image on the Primary CT image. Please note that the secondary 
CT image does not show on the View before superimposition is done. 

 

 

An error message appers when there is no registered secondary CT data. 

Please refer to the ‘Chapter 4. MPR Tab > 19. Data Manager’ for more information 
about registration process. 

The progress of data loading is shown on the View. 
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4. After completing superimposition, select Primary or Secondary option for VR COLORING 
and WINDOWING option to apply different settings for each primary and secondary CT. 

      

[Primary]       [Secondary] 

5. The changed value is applied on the 3D and 2D Views. 
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14. MPR Thickness 

The thickness of MPR 2D image can be changed. 

1. Click the right mouse button on the MPR 2D image. 

2. Click the Thickness option and select the thickness from the expanded list. The selected 
thickness will be applied to all MPR sectional images. 

 

 

▪ The default setting for MPR thickness can be changed in the Settings, and image will be 
restored to its original condition when resetting. 

▪ Once the thickness has changed, the Thickness option will disappear from the context 

menu. 
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15. MPR Interval  

The interval of MPR 2D image can be changed. 

1. Click the right mouse button on the MPR 2D image. 

2. Click the Interval option and select the interval from the expanded list. The selected interval 
will be applied to all MPR sectional images. 

 

 

▪ The default setting for MPR interval can be changed in Settings, and image will be 
restored to its original condition when resetting. 

▪ Once the Interval has changed, the Interval option will disappear from the context menu. 
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16. Setting MPR Axis 

The position of MPR axis can be reset according the axis of the inserted implant. 

1. Right click on the implant, which will be the standard for the axis rearrangement, to open 
the context menu. 

2. Click the [Set MPR Axis] option. The MPR axis changes in the direction of the implant axis. 

 

 

This MPR axis setting function does not work in the Section tab, 3D Pan tab, and the Multi 
Slice View. 
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17. View Switching 

User can check images by switching the one of the View Windows and the Main View Window. 
This View Switching function can be applied for the layout that includes "Main View Window.” 

1. Click the right mouse button on the image to send to Main View Window. 

2. Click the Switch to Main view option from the context menu. The selected View is displayed 
in the Main View Window. 
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18. Dual Monitor Mode 

18.1 Starting Dual Monitor Mode 

1. Click the [Start Dual Monitor Mode] button. 

  

 

If Ez3D-i fails to detect dual monitors, the [Start Dual Monitor Mode] button will not be 
activated. 

2. Ez3D-i enters into the Dual Monitor Mode displaying both Main View and Secondary View 
on each monitor. 

  

               Main View          Secondary View 

Dual Monitor Mode does not support following functions: 

▪ Control Panel: Oblique, Measuring Airway, Changing Layout, Drawing Curve 

▪ View Frame: Making a single window by doubling clicking the window title bar to 

▪ Context Menu: Presentation Mode On, Switching to main view 

▪ Short Key: <Ctrl + Enter> key 

 

18.2 Exiting Dual Monitor Mode 

Click the [x] icon at the top right corner of the Secondary View to exit Dual Monitor Mode. 
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19. Data Manager 

Data Manager Dialog manages the properties of 3D objects, IO Scanner data, Secondary CT 
data imported from EzDent-i and Ez3D-i. 

19.1 Data Manager Layout 

1. Click the [Data Manager] icon in the [ETC] option. 

 

2. The [Data Manager] dialog appears. 

   

▪ Name: The user can modify object name by double clicking object name. 

▪ Type: The user can choose the file type of the 3D object 

▪ Position: The user can set whether the model data is maxillary or mandible, or set its 
tooth code. 

▪ Registration: According to the registration status of the object, the [Active] or [Re-
register] button will be activated. 

 

▪ [Activate] 

: For objects that are included in EzDent-i data group, [Data Manager] will 
automatically appear in the [Data Manager] window to activate the objects. 

: For the unregistered data, [Name], [Type], [Show], [Lock], [Color] and [Opacity] 

options are not activated while only [Delete] option can be selected. 

▪ [Re-register] 

: For already registered objects, registration can be done with the [Re-register] 
option. 

: As old versions of Ez3D-i (less than v4.2) do not support registration option, data 
imported at these versions are regarded as registered data. Those data need to be 
registered with the [Re-register] button. 

▪ Show: Show or hide objects in the View 

▪ Lock: Lock or unlock to stop or allow changing object location 

▪ Color: Select the colors of objects 

▪ Opacity: Select the opacity of objects 

▪ Delete: Click the Delete button to remove the selected object in the view. 
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19.2 Data Registration 

1. Double click CT data in EzDent-i to start Ez3D-i. 

2. The [Data Manager] dialog appears automatically when Ez3D-i starts. 

 

The user can run Data Manager directly on Ez3D-i by clicking the [Data Manager] icon 
in the [ETC] toolbar group. 

3. For unregistered objects, click the [Active] button below the [Registration] option to activate 
the data. 

  

4. After activation, the [Registration] dialog appears automatically.  

  

5. Please proceed data registration. 

 

Please refer to ‘Chapter 1. Ez3D-i Basics > 5.7.1 Import Model, 5.7.2 Import 3D 
Photo, 5.7.3 Import Secondary CT’. 

6. The registered data can be seen on the Merged View of Registration dialog. 

7. Complete registration by clicking the [OK] button. 
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19.3 Data Re-register 

1. Click the [Data Manager] icon in the [ETC] toolbar group. 

 

2. The [Data Manager] dialog appears. 

3. For objects to be registered, press the [Re-register] button below the [Registration] option.  

  

4. The [Registration] dialog appears automatically. 

 

5. Please proceed data registration. 

 

Please refer to ‘Chapter 1. Ez3D-i Basics > 5.7.1 Import Model, 5.7.2 Import 3D Photo, 
5.7.3 Import Secondary CT’. 

6. The registered data can be seen on the Merged View of Registration dialog. 

7. Complete registration by clicking the [OK] button. 
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19.4 Changing Name of Data 

1. Click the [Data Manager] icon in the [ETC] toolbar group. 

 

2. The [Data Manager] dialog appears. 

  

3. Double click the object name to change the name of the object. 

 

▪ If the [Registration] option is [Active], you cannot rename the object as the Object 
Name is disabled. 

▪ The object name changed in Ez3D-i will not be reflected in EzDent-i. 

4. [Data Name] dialog appears. 

 

5. Change the name in the [Data Name] option and click the [OK] button. 
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19.5 Deleting Data 

1. Click the [Data Manager] icon in the [ETC] toolbar group. 

 

2. The [Data Manager] window appears. 

3. Press the [X] button of the object below the [Delete] option. 

 

4. When “Delete object (project name) from the project?” message appears, click the [OK] 
button to delete the object from the current project. 
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20. 3D Object Selection Guide 

3D Object Selection Guide as a form of bounding guide appears when a 3D object is being 
selected in the 3D View. 

  

▪ The 3D Object cannot be controlled by the 3D Object Selection Guide. 

▪ The 3D Object Selection Guide is able to move the selected object in the plane. 

 

  



Chapter 4. MPR Tab 
 
 

Ez3D-i User Manual 165 

21. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move images 

 
Zooming Zoom in or out 

 
Length Measure the distance 

 
Draw Canal Draw canal 

 
Capture View frame Capture the View frame area 

 
Reset View Initialize rotate, move, zoom 

 
Export Save the current image as a file. 

▪ Advanced Tools 

Icons Designation Description of Features 

 

Capture 

Select Window 
Capture 

Capture the selected window 

 

Capture 
Window 

Capture the View Window area 

 
Multi-Capture Capture multiple images 

 
Create Movie Run the movie capture program. 

 

Measurement 

Angle Measure the angle between three points 

 
Multi Angle Measure multi angle. 

 
Multi Length Measure multi length. 

 
Circle Measure Measure the radius of inserted circle 

 
Profile Density Profile between two points 

 
ROI 

Measure pixel, average value, maximum 
value and standard deviation of ROI 

 

Volume 
Measure 

Measure the volume of the threshold area 
from the selected area. 

 
Annotation Pointer Draw freely on the 2D and 3D image. 
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Icons Designation Description of Features 

 
Free draw Draw freely on the 2D image 

 
Memo Write memos directly on your images 

 

Sculpt 

Sculpt View the selected area separately 

 
Inverse Invert the Sculpt view area 

 
Undo Undo your last action 

 
Redo Revert Undo 

 
Reset Reset Sculpt 

 

On/Off 

Grid Check the scale of the image with grid 

 

Implant Long 
Axis 

Show/ Hide implant long axis 

 

Turn Overlay 
On/Off 

Show / Hide all input objects 

 
Show Manager Show / Hide individual input object 

 

Show/Hide 
Patient 

Information 

Show / Hide patient information on the 
image 

 

Etc 

Data Manager Manage properties of imported data 

 
Delete All Delete all input objects 

 
Initialize All Initialize all changes 

 

 

The following functions cannot be canceled <Esc> Key or with a mouse right click. 

Icons Designation Icons Designation 

 
Reset View 

 
Initialize All 

 
Undo 

 
Turn Overlay On/Off 

 
Redo 

 
Show Manager 

 
Reset 

 
Delete All 

 
Pointer 
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▪ [Create Movie] icon will not appear on the toolbar if the software to link is not set. 

▪ The data drawn using the [Pointer] function is not saved to the project file. 

▪ All functions are disabled while the [Pointer] function is in use. 

▪ Use the pointer function to draw on the current screen temporarily. 

▪ Click the [Annotation > Pointer] icon on the tool bar, and then the following window 
appears. 

 

 [Pointer]: Drag to draw and mark the area for View Frame. 

 [Eraser]: Erase the pointer overlay. The point overlay inserted on the path of the Erase 
icon moves will be deleted. 

 [Thickness]: Set the thickness of Pointer or Eraser. 

 [Pointer Color]: Set the color of Pointer. 

 [View Frame Capture]: Capture the View Frame while the pointer drawing mode is on. 

 [Reset Pointer]: Delete all pointer objects inserted on the image. 

 [Exit]: Close the Pointer function. 
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1. SECTION Tab Configuration 

The SECTION Tab is provided so that the user can examine the clinical structure of an image. 

Ez3D-i capabilities include Axial View, Panorama View, Section View, arch drawing and 
mandibular nerve drawing. 

1.1 Workspace 

 

▪ A is Axial Window screen. The information about the arch can be examined. Click the 
[Draw Curve] button to draw a curve along the arch. 

▪ B is Section Window screen. The information about a specific area of the image can be 
examined closely. Click the [Draw Canal] button to draw the canal along the 
mandibular nerve. 

▪ C is Panorama Window screen. The information about the image of the mandibular 
nerve can be examined. Click the [Draw Canal] button to draw the canal along the 
mandibular nerve. 

 

Imported data will not be displayed on the Panorama Window. 

  

A 

C 

B 

A 

C 

B 
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2. Drawing and Modifying Curve 

Enter the criteria for your panoramic image generation (interval, thickness). Then, click to draw 
a curve on the axial image and panoramic images are generated automatically. 

2.1 Drawing Curve 

A curve is detected and registered as the button 1 of curve list when entering to Section tab. When 

it fails to detect a curve, the default curve defined in the program is applied. 

 

After drawing a curve in the MPR tab, the screen will be automatically switched to Section tab, 
and the inserted curve will be added to the curve list. Refer to the ‘Chapter 4. MPR Tab > 8. 
Drawing Curve’ for the direction on how to insert a curve in the MPR tab. 

1. Click the [Draw Curve] button and the mouse cursor will change into drawing mode. 

 

2. Click points on the Axial Window to draw the curve line on the arch. Draw the curve line 
from left to right. Double click to complete the curve line. 

   

▪ Click the [Draw Curve] button while drawing the curve line to cancel the Draw Curve 
function. 

▪ Click the right mouse button while drawing the curve line to delete the previously 
inputted point. 

▪ The drawn curve is added to the Curve List. The number buttons on the Curve List will 
be activated according to the curves drawn.  
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If the curve line is drawn from right to left side, users will get a horizontally inverted 
image on the Panorama pane. 

3. The interval and the thickness of slice image created based on the curve can be changed. 

 

 

Use the mouse wheel to change the curve interval while drawing the curve line. 

 

2.2 Modifying Input Curve 

Click a point on the curve and drag it to the desired point to modify the line. 

▪ Moving point 

Click one of the curve points to select. And drag and drop the point to curve line. 

   

▪ Adding point 

After selecting the curve line, right-click to display a menu. Click the [Add Point] menu to 
add a new point. 
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▪ Moving curve 

To move the whole curve line, click the entire curve line and drag it to the desired location. 

   

▪ Adjusting curve length 

Move the start point and the end point of the curve line to adjust the length of the curve line. 

   

▪ Changing panorama thickness 

Click and drag the L/B point of the Panorama Thickness Line to adjust the thickness of the 
panorama view. Or right click on the image of the Panorama View to change the thickness. 
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▪ Changing width of Section images 

Click and drag the Section Width Point on the curve line to adjust the width of the Section 
images. 

  

  

Modifying the input curve will be reflected in real-time with the section view and panorama 
view. 
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▪ Switching L/B Direction 

Right click on the sectional line on the curve then click the [L/B Switching] button to change 

the sectional line direction. 

 

Please note that switching L/B direction does not change the direction of slices. 

 

2.3 Deleting Curve Point 

Select a point on the curve and right-click. Click the [Delete Point] menu to delete the selected 
point. 
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2.4 Deleting Curve 

1. Right click the number button to delete the corresponding curve. 

2. Click the [Delete Curve] option to delete the selected curve only. And click the [Delete All 
Curves] option to delete all inserted curves. 

 

3. If a curve is deleted, the numbers for inserted curves are rearranged automatically in the 
order of drawn time. 

2.5 Adjusting Section Panorama 

The section images can be adjusted through the Panorama window of SECTION tab. 

▪ Resizing Panorama Image (Vertical) 

Drag the edge of the Panorama image to resize. 

 

▪ Moving Section line 

Click the green line on the Panorama image and drag it upward or downward. The Section 
image are adjusted accordingly.  
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Set to show/hide sectional lines on Panorama View in the Settings. See ‘Chapter 2. Ez3D-i 
Settings > 3. View > 3.3 2D View’ for more information. 

 

▪ Moving Curve Positioning Line 

Click the pink line on the Panorama image and drag it to the left or right to move the Curve 
Positioning Line. 
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▪ Adjusting Curve Positioning Line 

Click the end points of the pink line on the Panorama image and drag it to the left and right 
to adjust the Curve Positioning Line. 

 

 

When the Curve Positioning Curve is not set in the 90 degrees, the pointed part on the 
Panorama image may not be displayed as the sectional image. 

▪ Resetting Curve Positioning Line 

Right click on the Curve Positioning Line to open the context menu. Click the [Reset Axis] 
option to reset the adjusted Curve Positioning Line. 
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3. Windowing 

Move the slider to adjust the brightness and the contrast of the 2D images. 

 

▪ Width: Move the slider to adjust the brightness (WIDTH) of the 2D image. The image is 
brighter with higher number. 

▪ Level: Move the slider to adjust the contract (LEVEL) of the 2D image. The image is clearer 
with higher number.  

▪ WINDOWING Icons 

Icons Designation Description of Functions 

 
Width Adjust the brightness of the image 

 
Level Adjust the contrast of the image 

 Smooth Make the image smooth 

 MIP 
Reduce the burring area of metal and make the 
image clearer (MIP: Maximum Intensity Projection) 

 Sharpen Sharpen the edge of image 

 Max Sharper Sharpen the edge of image to its maximum level 

 Inverse Inverse of black and white 

 VR Check the image in VR mode 

 Reset Initialize the image value 
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4. Canal Drawing 

4.1 Drawing Canal 

1. Click the [Draw Canal] icon on the toolbar. The mouse cursor changes to the drawing 
mode. 

2. To draw the canal line, click points along the mandibular nerve on the panorama window or 
the section view. 

    

3. Double click to complete the canal line. 

    

▪ The completion of canal line can be verified after all points are connected. 

▪ Right-click while drawing the canal line to delete the previously plotted input point. 

▪ Clicking the [Draw Canal] icon while drawing the canal line will cancel the Draw Canal 
function. The function can also be canceled by pressing the <Esc> key on the 
keyboard. 
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4.2 Editing Canal 

1. Right click on the inserted canal the following context menu appears. 

2. Click the [Edit Canal] menu and the canal points appear. 

 

 

Right click on the canal point to delete points. 

  

 

3. Right click on the canal and click the [Exit Editing Mode] menu after editing the canal. 

 

 

User can only move or delete the canal points on the 2D image. 

Double click to end the canal edit mode. 

4. There appears a message asking “Apply changes made to canal point?”  

 

5. Press the [OK] button, the new canal points will be applied to the canal. 
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4.3 Changing Properties of Canal 

1. Select the canal line and click the right mouse button. The following list appears. 

 

2. Click [Property] and the [Canal Property] window appears. 

 

3. Click the [Canal Diameter] dropdown menu to select the diameter of the canal line. Click 
[Canal Color] and select the color of the canal line. 

4. Click the [OK] button and the changes are reflected in the canal line. 

4.4 Hiding or Deleting Canal 

Select the canal line and click the right mouse button. The following list appears. 

▪ Click [Hide] and the canal line disappears from the screen. 

 

▪ Click [Delete] to delete the selected canal line. 

 

 

▪ Click the [Show Manager] icon. The [Show/Hide Manager] window appears. 

 

▪ Uncheck a box to hide the object/canal drawing/measurement. Click the [OK] button 

and the selected canal line disappears from the screen 
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5. Measuring Length 

1. Click the [Length] icon to measure the length as below. 

 

2. Click two points to measure the length. Then the numerical value appears on the screen. 

 

3. Click the [Length] icon again (or right-click the mouse, click the <ESC>) key to finish 
measuring. 
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6. Full Screen Mode 

            

 

            

Double click the image in the Section view on the Section tab to view the image in the full 
screen mode without changing the layout.  

Double click the image in the full screen mode to return to the previous layout. 
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7. Dual Monitor Mode 

7.1 Starting Dual Monitor Mode 

1. Click the [Start Dual Monitor Mode] button. 

  

 

If Ez3D-i fails to detect dual monitors, the [Start Dual Monitor Mode] button will not be 
activated. 

2. Ez3D-i enters into the Dual Monitor Mode displaying both Main View and Secondary View 
on each monitor. 

 

               Main View          Secondary View 

Dual Monitor Mode does not support following functions: 

▪ Control Panel: Changing Layout 

▪ View Frame: Making a single window by doubling clicking the window title bar 

▪ Context Menu: Presentation Mode On 

▪ Short Key: <Ctrl + Enter> key 

  

7.2 Exiting Dual Monitor Mode 

Click the [x] icon at the top right corner of the Secondary View to exit Dual Monitor Mode. 
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8. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move images 

 
Zooming Zoom in or out 

 
Length 

Measure the distance between two points on the 
2D image 

 
Draw Canal Draw canal 

 
Capture View Frame Capture the View frame area 

 
Reset View Initialize rotate, move, zoom 

 
Export Save the current image as a file. 

▪ Advanced Tools 

Icons Designation Description of Features 

 

Capture 

Capture Region Capture the selected area 

 
Capture Window Capture the View Window Area 

 
Multi-Capture Capture multiple images 

 
Create Movie Run the movie capture program. 

 

Measurement 

Angle Measure the angle between three points. 

 
Multi Angle Measure multi angle 

 
Multi Length Measure multi length. 

 

Circle 
Measurement 

Measure the radius of inserted circle 

 
Profile Density Profile between two points 

 
ROI 

Measure pixel, average value, maximum 
value and standard aviation of ROI 

 
Annotation 

Pointer Draw freely on the 2D and 3D image. 

 
Free draw Draw freely 
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Icons Designation Description of Features 

 
Memo Write memos directly on your images 

 

On/Off 

Grid Check the scale of the image with grid. 

 

Implant Long 
Axis 

Show/ Hide implant long axis 

 

Turn Overlay 
On/Off 

Show / Hide the entire input objects 

 
Show Manager Show / Hide individual input object 

 

Show/Hide 
Patient 

Information 

Show / Hide patient information on the 
image 

 

Etc 

Data Manager Manage properties of imported data 

 
Delete All Delete all input objects 

 
Initialize All Initialize all changes 

 

 

The following functions cannot be canceled with the <Esc> key or with a mouse right 
click. 

Icons Designation Icons Designation 

 
Reset View 

 
Initialize All 

 
Turn Overlay On/Off 

 
Show Manager 

 
Delete All 

 
Pointer 

 

 

▪ [Create Movie] icon will not appear on the toolbar if the software to link is not set. 

▪ The data drawn using the [Pointer] function is not saved to the project file. 

▪ All functions are disabled while the [Pointer] function is in use. 

▪ Use the pointer function to draw on the current screen temporarily. 

▪ Click the [Annotation > Pointer] icon on the tool bar, and then the following window 

appears. 

 

 [Pointer]: Drag to draw and mark the area for View Frame. 

 [Eraser]: Erase the pointer overlay. The point overlay inserted on the path of the Erase 
icon moves will be deleted. 

 [Thickness]: Set the thickness of Pointer or Eraser. 

 [Pointer Color]: Set the color of Pointer. 

 [View Frame Capture]: Capture the View Frame while the pointer drawing mode is on. 

 [Reset Pointer]: Delete all pointer objects inserted on the image. 

 [Exit]: Close the Pointer function. 
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1. 3D PAN Tab Configuration 

The 3D PAN tab provides the user the ability to simulate implant placement at a desired tooth 
location. 

The implant simulation capability of Ez3D-i includes the implant placement, the implant library 
and bone density estimation around the implants. 

1.1 Workspace 

 

▪ A is the 3D Volume Window screen. 

▪ B is the Scout Window screen. 

▪ C is the section view window screen (2D view window), which is defined by the navigator of 
3D view and by the controller of 2D view. 

  

A 

B 

A 

B C 
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2. Navigator 

Navigators on 3D and 2D images are used to adjust the image view and display the cross-
sectional view. 

2.1 3D Navigator on 3D image 

The 3D navigator consists of a frame that indicates the cross-sectional image of panorama 3D 
and the indicator lines that displays the corresponding cross-sectional images. 

 

No Name Description 

A Frame 
The default size of the frame is 30mm x 35mm x 35mm, and the size 
can be changed in the [Settings > View > 3D View > Volume 
Panorama Navigator]. 

B Axial Indicator Line 
Also called Axial line. It displays and sets the location of Axial View, 
which divides the image within the navigator horizontally. 

C 
Sectional Indicator 

Line 
Also called Section line. It displays and sets the location of Section 
View, which divides the image within the navigator vertically. 

D Rotating Controller 
The Rotating controller rotates the Navigator to view cross sectional 
images. 

 

 

▪ The navigator can be displayed or hidden by pressing the Space Key on the keyboard. 

▪ The navigator is only displayed when the 3D panorama volume is set in the Front view. 

 

  

A 

D 
B 

C 
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2.1.1 Moving Navigator 

User can move the Navigator and change the displayed range. 

▪ Drag the inside of the Navigator to change its location. When moving, the rotation value 
and the position of section line are maintained. 

 

▪ Double click the desired spot to view the cross-sectional image. The navigator moves to the 
selected position. In this case, the rotation value and the position of section line are reset. 
Also, if the user double clicks the inside of Navigator, the navigator rotates back to its 
original position based on the clicked spot. 
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2.1.2 Rotating Navigator 

User can rotate the Navigator and change the displayed range. 

▪ Click the Navigator and scroll the mouse wheel. The navigator rotates based on the 
intersecting point between the Axial Line and the Section Line. 

 

▪ Drag the Control buttons on either side of Navigator Box. The navigator rotates based on 
the other unselected button. 

 

 

The Overlay displaying the direction of Axial View automatically changes as the navigator 
rotates. 
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2.1.3 Moving Indicator Line 

User can move the Line Indicator and view the cross-sectional images for corresponding point 
accordingly. 

▪ Drag and move the Line Indicator. The 2D images change accordingly. 

 

 

Line Indicator moves while maintaining the interval. The interval and thickness can be 
changed in the Setting. 

▪ Click the intersecting point between the Section Line and Axial Line and drag to move the 
lines at the same time. 
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2.2 Axial Navigator 

Axial Navigator is the controller that displays the same location of Section line of 3D Navigator 
and can be adjusted on the Axial view. The Section Line only can be rotated. 

Drag the Rotation button at both ends of the Section Center Line to rotate the Section line in the 
Axial direction. The Section Line rotates based on the intersecting point between the predefined 
Arch Line and the Section Center Line and the intersecting point cannot be moved. 

  

 

The Section Controller and the Section Line can be displayed or hidden by pressing the 
Space Key on the keyboard. 

 

The Section Controller and the Section Line can be displayed or hidden by pressing the 
Space Key on the keyboard. 
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3. Clipping 

The Clipping function is to cut a 3D image in the selected direction to view the cross-sectional 
image. 

1. Click the [Apply Clipping] button to execute clipping function. 

 

2. Click to select the direction to clip a 3D image. 

 

3. Click the combo box to set the area for clipping. 

 

4. Drag the slider and the image will be clipped in the selected direction. 

 

 

To reset the clipping, click the [Reset Clipping] button. 
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4. Bone Density 

The bone density of selected cross-sectional images can be checked. 

In the Windowing Group, click the [Bone Density] Button to display all 2D images in the Bone 
Density mode. Move the slider at the bottom of the screen to change the Sectional image 
position. 

 

 

 

Adjusting bone density range depending on the equipment that you have is required to use 
the bone density function more accurately. (There are many cases where CBCT has 
different CT Number values, which are the standard of bone density standard, depending on 
the equipment.) 

Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

 

Because the CT Number can be different by acquisition equipment, the values can be set 
according to the user's equipment in the Settings. Bone density area (D1 - D5) can be 
changed to appropriate CT Number based on the user's acquisition equipment in the 
[Settings > Simulation > Bone Density > Bone Density Area], and also the color can be 
changed. 
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5. Panorama View 

User can select an area to view in panorama. 

 

3D Panorama has been reconstructed from CT image.  

Users should be aware of this limitation before diagnosing and performing simulation 
according to the panorama image. Please use it with caution in making a diagnosis. 

 

1. Click the [Create Pano] button. The [Create Panorama] dialog appears to select an area. 

 

 

Click to use tools to move or zoom the image and to edit the curve point. 

 

2. Drag and drop the lines to adjust the area in the Front view window. 
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3. Drag the curve point and L/B point to adjust the selected area in the Curve view. 

 

4. Review the 2D image in the Panorama window based on the selected area in the Front and 
Curve view windows, and then click the [OK] button. The Create Panorama dialog closes 
and the Volume Panorama for the selected area is displayed. 

 

 

The imported STL is not displayed in the 3D Panorama pane, but only in the Section image 
pane. 
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6. Implant Simulation 

Implants can be inserted with Insert Implant button including Smart, Axis, Click Point options, or 
by measuring length of a certain tooth. 

6.1 Inserting Implant 

 

Please refer to the ‘Chapter 4. MPR Tab > 9. Implant Simulation’ to learn more details about 
Smart/Axis/Click Point, Single/Multiple, Implant/Guide/Path/Crown options on the Implant 
Property dialog. 

1. Double click on the image to designate the point for implant insertion, and then click the 
[Insert Implant] button.  

 

2. The Implant Manager window appears. (When double clicking, the Axial and Section 
images will be shown accordingly.) 

 

3. Select the appropriate tooth number, company name, implant line up and implant model for 
simulation from their respective dropdown menus. 
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4. Click the [OK] button. The simulated implant is placed the previously designated tooth 
location. 

 

5. After inserting an implant, right click the implant and then click the [Show Info] menu. Then 
it shows the information of the fixture inserted. 
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6.2 Inserting implant by Measuring Length 

1. Click the [Length] icon. 

 

2. Measure the length by clicking two points in the 2D Coronal image of the tooth for implant 
simulation. At this time, first clicked point is considered as Occlusal, and second point is 
considered as Apical. 

 

3. After completing the measurement, click the [Length] icon again to return the Normal 
Cursor mode. 

 

On the [3D PANORAMA] window of the 3D PAN tab, the length measuring is not 
available. Like this case, when the 3D length measuring is not available, following 
message appears. 

 

4. Click the line indicated by the measured length, and then click the right mouse button. Upon 
clicking the right mouse button, the following list appears. 
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5. Click the [Insert Implant] menu, then it shows three fixtures that are recommended with the 
information of Apical and length. When user selects one of them, the fixture is automatically 
inserted. 

  

▪ Default implant value depending on the measured length 

When the implant placement simulation is performed with the [Length] icon, the implant 
default value is selected based on the approximation of the measured length, not the 
corresponding tooth number. The user can select the implant value as desired by 
moving the scroll bar up and down. 

 

 

>>The implant default value determined by the approximation of the measured length 

 

If implant information does not show in the [Implant Property] window, install Implant 
DB. Implant DB installation is described in the Installation and Server Manual. 
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6.3 Copying and Pasting Implant 

1. Right click on the inserted implant to open the context menu. 

2. Click the [Copy Implant] option to copy the selected implant. 

 

 

The Tooth Code is not included in the copied implant information. 

Enter or edit the Tooth Code in the Property menu of the copied implant. 

 

3. Right click on the point where you want to insert implant to open the context menu. 

4. Click the [Paste Implant] option. The copied implant is inserted. 

6.4 Editing Implant 

1. Right click on the inserted implant to open the context menu. 

2. Click the [Edit Implant] option. 

3. Use the + / - button to edit the Length, Occlusal, and Apical information. 

 

▪ The Company and the Model (line-up) can be modified if they are applied from the 
same company and the model group. 

▪ Occlusal Diameter can be only adjusted to the width that the currently selected Length 
supports. 

▪ Apical Diameter can be only adjusted to the width that the currently selected Occlusal 
Diameter supports. 
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6.5 Editing Crown 

1. Right click on the crown of the inserted implant to open the context menu. 

2. Click the [Edit Crown] option. 

3. Use the + / - button to edit the Mesial/Distal, Lingual/Buccal, and Height information. in the 
[Edit Crown] window. 

 

 

6.6 Moving, Rotating and Locking Implant 

6.6.1 Moving, Rotating and Locking 3D image 

The inserted implant can be moved on the 3D image. The selected implant moves horizontally 
with the direction of the current 3D image. 

Double click or right click on the implant to show the controller. Click and drag the arrow of the 
controller to move or rotate the implant as desired. 

  

Implant Controller Crown Controller 
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▪ Moving 

1. Click one of the six arrows. The color of the selected arrow changes. 

 

2. Move with the up/down arrow keys on the keyboard: down arrow key moves to the left by -
0.1mm and the up-arrow key moves to the right by +0.1mm. 

3. Click the other arrows or rotation controller to cancel the selection. 

▪ Rotating 

a. Click one of the three rotation controllers. The color of the selected controller changes. 

 

b. Move with the up/down arrow keys on the keyboard: up arrow key turns it clockwise by 
one degree and the down arrow key turns it counterclockwise by one degree. 

c. Click the other arrows or rotation controller to cancel the selection. 

▪ Locking/ Unlocking 

a. Right click on the implant and select the [Lock] option to fix the location of the implant. 

b. Right click on the locked implant and select [Unlock] option to change the location of 
the implant.  
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6.6.2 Moving, Rotating and Locking 2D image 

After choosing the implant from a 2D image, a control line is created to rotate the implant. Click 
and drag a point to move and rotate the implant. 

 

Click on the implant. When the mouse cursor changes to the cross , the implant can be 

moved. And when the mouse cursor changes to the curved arrow , the implant can be 
rotated. 

 

Right click on the implant and select the [Lock] option to fix the location of the inserted implant 
on 2D images as well as 3D images. 

▪ Selecting implant from the Implant list 

When two or more implants are inserted, user may select an implant from the list to display 
the controller of the relevant implant. At this time, the axis of 2D Section images changes 
accordingly. 

>> When selecting implant for tooth number 13 

 

>> When selecting implant for tooth number 32 

▪  
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6.6.3 Changing Property of Implant 

The properties of inserted implant, such as the tooth number, company, line-up, color, crown 
simulation, and crown color can be changed. 

▪ 2D View 

a. Click the inserted implant on the 2D image viewer. Right click the implant and the 
following list appears. 

 

b. Click the [Property] menu and the [Implant Property] window appears. Change the 
implant properties. 

c. Click the [OK] button. The changes are saved and displayed on the image. 

▪ 3D View 

a. Right click the implant from the Implant List and click the [Property] menu. The Implant 
Manager window appears. 

b. Change the [Property] menu and the [Implant Property] window appears. Change the 
implant properties. 

c. Click the [OK] button. The changes are saved and displayed on the image. 
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6.7 Hiding and Deleting Implant 

1. Right click the implant from a list or on image for 3D view. For implant inserted in 2D view, 
right click the implant 

2. Click the [Hide] option to hide the implant from the screen or the [Delete] option to delete 
the implant. 

• 3D View 

   

• 2D View 
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6.8 Moving, Rotating and Locking Crown 

The inserted Crown Object can be rotated and moved. 

▪ When the crown is inserted with implant 

When the Implant Object and Crown Object are inserted as a set, the group of Implant and 
Crown Object is rotated or moved like the Implant Object 

  

▪ When the crown is inserted alone 

When the Crown is selected for moving or rotation, control points are created in the 
direction of Crown Axis and Occlusal / Root. 

• Rotating 

 Drag the Control Point or the Crown Axis outside of control point and the crown 

rotates based on the other unselected point. 

 

 Click and select Crown, and then press the up or down arrow key on the keyboard 

to rotate the crown. 

• Moving 

 Click the inside of crown other than the Crown Control Point and drag it to move 

its position. 
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• Locking/ Unlocking 

 Right click on the crown and select the [Lock] option to fix the location of the 

crown. 

 

 Right click on the locked crown and select [Unlock] option to change the location 

of the crown. 

 

 

The moving, rotating and locking method for 3D Control is the same with the Implant 
Object, and the crown and implant moves at the same time on 3D view. 
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7. Drawing Canal 

7.1 Drawing Canal 

1. Click the [Draw Canal] icon on the toolbar. The mouse cursor changes to the drawing 
mode. 

2. To draw the canal line, click points along the mandibular nerve on 2D and 3D images. 

 The drawing method is the same on the 2D and 3D viewers, but on 3D viewer, 
clipping and sculpting precede drawing canal. 

 Right-click while drawing the canal line to delete the previously plotted input point 

3. Double click to complete the canal line. 

 The completion of canal line can be verified after all points are connected. 

 Clicking the [Draw Canal] icon while drawing the canal line will cancel the Draw 
Canal function. The function can also be canceled by pressing the <Esc> key on 
the keyboard. 

 The canal drawn is displayed on all tabs, and particularly it appears the same in 
the 3D VR coloring mode. 

7.2 Editing Canal 

1. Right click on the inserted canal the following context menu appears. 

 

2. Click the [Edit Canal] menu. The inserted canal points appear on the 2D and 3D images. 
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▪ Right click on the line connecting the canal point to add points. 

 

▪ Right click on the canal point to delete points. 

 

3. Right click on the canal and click the [Exit Editing Mode] menu after editing the canal. 

 

4. There appears a message asking “Apply changes made to canal point?”  

 

5. Press the [OK] button, the new canal points will be applied to the canal. 

 

▪ The image can be moved, zoomed in or out only using the shortcut keys while editing 
canal. 

▪ When the canal point is selected on the 3D image, the MPR axis is adjusted 
automatically to display the sectional image where the corresponding point is inserted. 

▪ User can only add or delete the canal points on the 3D image. 

▪ User can only move or delete the canal points on the 2D image. 

▪ Double click to end the canal edit mode. 
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7.3 Changing Properties of Canal 

1. Select the canal line and click the right mouse button. The following list appears. 

 

2. Click the [Property] menu and the [Canal Property] window appears. 

 

3. Click the [Canal Diameter] dropdown menu to select the diameter of the canal line. Click 
[Canal Color] and select the color of the canal line. 

4. Click the [OK] button and the changes are reflected to the canal line. 

7.4 Hiding or Deleting Canal 

Select the canal line and click the right mouse button. The following list appears. 

▪ Click [Hide] and the canal line disappears from the screen. 

 

▪ Click [Delete] to delete the selected canal line. 

 

 

1. Click the [Show Manager] icon. The Show/Hide Manager window appears. 

 

2. Uncheck a box to hide the object/canal drawing/measurement. Click [Close] and the 
selected canal line disappears from the screen. 
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8. Collision Detection 

The Collision Detection function detects the collision between inserted implant and canal or 
between implant and implant. The collision detection recognizes it as collision when the safety 
zone and the implant or canal are collided. When the safety zone and safety zone are collided, 
it does not recognize it as collision. 

▪ Safety Zone 

The Safety zone displays the area where canal or implant cannot be inserted. The 
boundary size for safety zone can be changed in the [Settings > Simulation > General > 
Collision Detection], and the boundary size is indicated on the basis of implant. 

  

Implant and Canal Implant and Implant 

▪ Collision Detection 

When collision is detected between implant and canal or between implant and implant, the 
color of safety zone changes and warning message 'Collision Warning!' pops up. 

▪ Implant and Canal 

  

▪ Implant and Implant 
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9. Changing Section View Thickness and Interval 

The thickness and interval of the Section View, which displays the cross-sectional images where 
the navigator is located, can be changed. 

▪ Changing Thickness 

1. Click the right mouse button on the cross-sectional view pane. 

2. Click the [Thickness] option and select the thickness from the expanded list. The 
selected thickness will be applied to all cross-sectional images. 

 

▪ Changing Interval 

1. Click the right mouse button on the cross-sectional view pane. 

2. Click the [Interval] option and select the interval from the expanded list. The selected 
interval will be applied to all cross-sectional images. 

 

 

▪ The default value for thickness and interval can be changed in the [Settings > View > 
3D View > Volume Panorama Navigator]. 

▪ Once the thickness or the interval has changed, the relevant option will disappear from 

the context menu. 
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10. Dual Monitor Mode 

10.1 Starting Dual Monitor Mode 

1. Click the [Start Dual Monitor Mode] button. 

 

 

If Ez3D-i fails to detect dual monitors, the [Dual Monitor Mode Start] button will not be 
activated. 

2. Ez3D-i enters into the Dual Monitor Mode displaying both Main View and Secondary View 
on each monitor. 

 

               Main View          Secondary View 

 

Dual Monitor Mode does not support following functions. 

▪ Control Panel: Changing Layout 

▪ View Frame: Making a single window by doubling clicking the window title bar to 

▪ Context Menu: Presentation Mode On 

▪ Short Key: <Ctrl + Enter> key 

  

10.2 Exiting Dual Monitor Mode 

Click the [x] icon at the top right corner of the Secondary View to exit Dual Monitor Mode. 
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11. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move the image 

 
Zooming Zoom in or out 

 
Length 

Measure the distance between two points on the 
2D image 

 
Draw Canal Draw canal 

 
Capture View Frame Capture the View frame area 

 
Reset View Initialize rotate, move, zoom 

 
Export Save the current image as a file. 

▪ Advanced Tools 

Icons Designation Description of Features 

 

Measurement 

Angle Measure the angle between three points 

 
Multi Angle Measure multi angle 

 
Multi Length Measure multi length. 

 

Circle 
Measurement 

Measure the radius of inserted circle 

 
Profile Density Profile between two points 

 
ROI 

Measure pixel, average value, maximum 
value and standard deviation of ROI 

 
Volume Measure 

Obtain the volume of the threshold area 
from the selected region 

 

Capture 

Capture Region Capture the selected region 

 
Capture Window Capture the View Window area 

 
Multi-Capture Capture multiple images 

 
Create Movie Run the movie capture program. 

 
Annotation Pointer Draw freely on the 2D and 3D image. 
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Icons Designation Description of Features 

 
Free draw Draw freely 

 
Memo Write memos directly on your images 

 

Sculpt 

Sculpt View the selected area separately 

 
Inverse Invert the Sculpt area 

 
Undo Undo your last action 

 
Redo Revert Undo 

 
Reset Initialize Sculpt 

 

On/Off 

Grid Check the scale of the image with grid. 

 
Implant Long Axis Show/ Hide implant long axis 

 

Turn Overlay 
On/Off 

Show / Hide all input objects 

 
Show Manager Show / Hide the individual input objects 

 

Show/Hide 
Patient 

Information 

Show / Hide patient information on the 
image 

 

Etc 

Data Manager Manage properties of imported data 

 
Delete All Delete all input objects 

 
Initialize All Initialize all changes 

 

 

The following functions cannot be canceled with the <Esc> key or with a mouse right 
click. 

Icons Designation Icons Designation 

 
Reset View 

 
Initialize All 

 
Undo 

 
Turn Overlay On/Off 

 
Redo 

 
Show Manager 

 
Reset 

 
Delete All 

 
Pointer 
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▪ [Create Movie] icon will not appear on the toolbar if the software to link is not set. 

▪ The data drawn using the [Pointer] function is not saved to the project file. 

▪ All functions are disabled while the [Pointer] function is in use. 

▪ Use the pointer function to draw on the current screen temporarily. 

▪ Click the [Annotation > Pointer] icon on the tool bar, and then the following 
window appears. 

 

 [Pointer]: Drag to draw and mark the area for View Frame. 

 [Eraser]: Erase the pointer overlay. The point overlay inserted on the path of the Erase 
icon moves will be deleted. 

 [Thickness]: Set the thickness of Pointer or Eraser. 

 [Pointer Color]: Set the color of Pointer. 

 [View Frame Capture]: Capture the View Frame while the pointer drawing mode is on. 

 [Reset Pointer]: Delete all pointer objects inserted on the image. 

 [Exit]: Close the Pointer function. 
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1. ENDO Tab Configuration 

ENDO tab provides functions especially for Endodontics and enables users to set VOI and 
conduct Root Canal simulation. 

1.1 Workspace 

   

▪ A Section: VOI (Volume of Interest) Window to display selected area in Panorama View 

▪ B Section: View Window to display Panorama Curve area in 3D Panorama 

▪ C Section: View Window to display cross-sectional image of Navigator/Root Canal Axis 

▪ D Section: View Window to display cross-section of Endo Navigator Axis after rotating 
based on Axis 

▪ E Section: View Window to display cross-sections based on Endo Navigator/Canal 
cross-sections 

  

 

A B 

C 

D 

E 
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1.2 Control Panel 

   

Control panel is an area where main functions to manipulate views are grouped. Configuration 
may differ according to the Tab that the user selected.  

No Name Description 

1 Mode Group Radio to change to Endo Navigator or Canal cross-sections mode 

2 Root Canal Group Function group to insert Root Canal and select to view the 
inserted Root Canal 

3 VOI Group Function group to select options to display in VOI View (Only 
Tooth Segmentation Data/With Root Curvature)  

4 Pulp Level Offset Slider to change the center value of VR Coloring Graph 

5 3D PANOROMA Group Function to adjust 3D Panorama area and Rendering Mode 

6 WINDOWING Group Function to adjust Width/ Level value or set Image Effect in image 
displayed in 2D View 

7 Change Layout button Button to change frame layout  

8 Set Dual Monitor Mode 
button 

Button to enter into Dual Monitor mode 

9 Open Report button Button to open Report 
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2. ENDO Navigator 

Image can be viewed using ENDO navigator in Panorama View. VOI area is updated according 
to the change of ENDO navigator location and direction. Basic operations of the navigator is 
same as 3D PAN tab 

2.1 Displaying Navigator Area 

▪ VOI View 

Image is rendered into Endo mode to easily view Root Canal in VOI View. 

 

 

Functions including zooming in/out, moving, and rotating can be conducted, and 
basic operations are the same as 3D View. 

However, shortcut key for zooming function is replaced with Ctrl + Mouse scrolling. 

Mouse scrolling can be used to move Curvature Overlay according to Canal cross-
sections. 

Volume orientation can be selected by clicking direction buttons at the bottom, and each 
direction faces the following direction. 
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▪ Scout View 

Basic properties of Scout View displayed in a mode where sectional image can be selected 
using ENDO navigator are the same as those of MPR image. 

When selecting ENDO Navigator When selecting Canal cross-sections 

  

▪ Sectional Axis: Vertical Line to 
display progress direction of 
Endo Navigator Sectional Line.  

▪ Section Line: Sectional Line 
Overlay of Endo Navigator. 

▪ However, Sectional Axis/Line 
cannot be moved/rotated. 
Function to change Scout image 
slice is not supported. 

Axis is updated to the position of Section Center 
View in Canal cross-sections function. 

▪ Oblique View 

User can move cross-sectional image to view while rotating based on Sectional Axis. 

 

 Guideline: Guideline is displayed at the location of Section Center View 

 Oblique Controller : Image is rotated (0~360 degree) based on Section Axis 

Oblique View is displayed with magnification ratio of MPR image. 

 

 Endo Navigator Reference: Cross-section of Axis 

 Canal cross-sections Reference: Canal Plane position 
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2.2 Changing ENDO Navigator Mode 

Navigator mode can be set using radio buttons provided in Mode Group in Control Panel. 

        

[Endo Navigator Mode]             [Canal Cross-sections Mode] 

 

2.3 Locking/Unlocking ENDO Navigator  

1. Right click the navigator of overlay in Panorama View. 

2. Click the [Navigator Lock/Unlock] provided in context menu to lock/unlock.  

 

 

The following message appears when the selected Canal is not included in 
VOI and the navigator is locked. Click [Yes] to unlock the Navigator. 
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2.4 Changing Navigator Size 

1. Right click the Navigator. 

2. Click the [Resize Navigator] provided in context menu.   

 

3. Section Line moves to the center of Endo Navigator and is hidden. 

4. The user can adjust size by selecting a point and moving 

5. When completed, right click the navigator and click [Exit Resizing Mode] button in context 
menu.   

 

Navigator cannot be rotated while changing Navigator size. 
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3. Curve Detection 

Curve is displayed on the screen when entered ENDO tab. If it fails to detect curve, the user 
can set a curve. 

3.1 Displaying Curve 

1. Open CT data.  

2. Panorama Curve is displayed when ENDO tab is selected. 

 

3. When arch is successfully displayed, each view displays corresponding image to create 3D 
Panorama. 

 

3.2 Defining Arch by User 

1. Open CT data.  

2. Panorama Curve is displayed when ENDO tab is selected. 

3. When curve is not properly displayed, the following error message appears. 

 

4. Click the [Yes] button to automatically display [Define Arch] dialog. 
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5. Define Arch by using editing/inserting Arch functions. 

6. Click [OK] button to apply changes 

 

The arch set by user-define function is initially shared with 3D PAN/ ENDO Tab, then 
edited/managed separately. 

Checking the [Applies to all 3D Panorama] checkbox at the bottom left of the [Define Arch] 
dialog will share the arch set by user-define function with all 3D panorama. Uncheck the 
checkbox to prevent the arch from being shared. 

 

3.3 Editing Curve 

1. Click [Create Pano] button in Control Panel.  

2. [Define Arch] dialog appears. 

 

3. Change the Curve of Panorama. 

4. Click [OK] to apply changes. 

 

If existing panorama arch has measurement and/or annotations, the following message 
appears. 

  

Clicking the [Yes] button will delete all measurement and annotation to apply the arch. 

If the [Applies to all 3D Panorama] checkbox is checked, it checks for all 3D panoramas 
whether each of them has measurement and/or annotations. 

 

Endo Navigator is initialized when the edited Curve is applied. 

Canal cross-sections option is changed to be unchecked when the edited curve is applied. 

Image is updated in the View Frame based on the edited Panorama Curve 
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4. Drawing Root Canal 

Basic operations of Root Canal Simulation function are the same as Canal drawing. 

4.1 Drawing Root Canal 

1. Click [Draw Root Canal] button in Control Panel.  

 

2. Insert point by clicking the position where Root Canal exists in 2D View. 

 

The entered point is displayed both in 2D and 3D View, and Endo Navigator can be 
moved/rotated while drawing Root Canal. 

3. Select [Draw Root Canal] button to terminate when entering point is complete. 

4. New Root Canal item is added to Root Canal List, and Root Canal overlay is displayed in 
all Views. 
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Please refer to the following table for more details about overlays displayed in 2D/3D area. 

3D 2D 

  

▪ Information of the selected Root Canal is 
displayed in Billboard format in VOI View. 

▪ Root Canal Label can be selected and moved 
by a user. 

▪ Name and total length of Root Canal are 
displayed.  

▪ Root Canal Label is displayed at the first 
entered Root Canal Point in [Draw Root 
Canal] function. 

▪ Connection Line of Root Canal Label is 
displayed as dotted line. 

▪ Root Canal Overlay of cross-section is 
displayed as a line in 2D View. 

▪ Line of the selected Root Canal is displayed 
thicker. 

 

 

4.2 Selecting Root Canal 

1. The entered Root Canal is displayed in the list up to 100.  

2. The user can select desired Root Canal from Root Canal List or click directly on the View to 
select. 

 

3. VOI is updated with the selected Root Canal. 

4. Endo Navigator, Section Plane, and 2D Image are updated based on the updated VOI. 
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4.3 Showing/Hiding Root Canal 

1. Select/Deselect Show check button in Root Canal List.  

 

2. The selected Root Canal is displayed in View while unselected Root Canal is hidden from 
the View. 

4.4 Displaying Root Canal Cross-section 

1. Select a Root Canal to use in Canal Cross-sections function.  

 

2. Select [Canal Cross-sections] radio button.  

 

3. Section Plane is displayed in VOI View. 

 

4. Image is updated according to Section Plane. 

5. If another Root Canal is selected, VOI is updated according to the selected Root Canal. 
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4.5 Setting Root Canal Properties 

1. Select an item in Root Canal List or VOI View, and right click.  

2. Select Property to open Root Canal Property dialog. 

 

3. Edit properties including Name, Diameter, and Color. 

 

4. Click [OK] button to save changes. 

 

[OK] button is not enabled when Name is not entered, and the following message appears 
when duplicated name exists. 

 

When this message appears, click [Close] button and try again with a name which is not 
duplicated. 

5. When Root Canal Property is changed, the list is updated. 

 

4.6 Deleting Root Canal 

1. Select an item in Root Canal List or VOI View, and right click. 

2. Select Delete menu. 

3. The selected Root Canal is deleted from the list. 

 

When all Root Canals are deleted in [Canal Cross-sections] mode, it automatically changes 
to [Endo Navigator] mode. 
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4.7 Editing Root Canal Point 

Shape of the entered Root Canal can be edited by moving points in Edit mode. Basic operations 
are the same as editing canal in MPR Tab. 

1. Select an item in Root Canal List or VOI View, and right click. 

2. Select Edit Root Canal menu.  

 

3. The selected Root Canal enters Edit mode, and points consisting Root Canal overlay are 
displayed. 

 

4. Drag and drop a Root Canal point to the desired position. 

 

5. To add a Root Canal point, right click on the desired point of the Root Canal overlay on VOI 
view then, select the [Add Point] from the context menu. 

6. Select Exit Root Canal menu to complete. 
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5. Displaying VOI 

5.1 Displaying Tooth Data 

This is a function to display Tooth Segmentation result in VOI. 

1. Select Segmented Teeth check button. The button is disabled when there is no Tooth 
Segmentation result.  

 

2. Only Tooth Segmentation data area is displayed in VOI, and only Root canals included in 
VOI is displayed in overlay. 

 

3. Click the [Apply Clipping] button then select the desired region using the slider bar. 

 

4. Only the region selected is displayed on the VOI view. 
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5.1.1 Sculpting Selected Region 

Select an area to be displayed on the VOI view. 

1. Select a sculpting tool from the toolbar. 

▪ [Free Sculpting]: Select an area by drawing freely. 

▪ [Polygonal Sculpting]: Select an area by connecting the points inserted with straight 
lines. 

2. Select an area then the [Delete Here] message appears outside of the selected area. 

 

 

For [Polygonal Sculpting], double click on the last point to automatically generate a polygon 
by connecting the points inserted. 

3. Click the [Delete Here] to remove the surrounding objectives and view only the selected 
area on the VOI view. 
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5.2 Changing VR Coloring 

Apply the desired VR coloring value and view the optimized image. 

1. Select either Teeth, Endo, or Setting to apply the pre-set coloring on a 3D image. 

2. Control the VR coloring icons to change the 3D VR values and to make fine adjustment to 
the values. 

▪ Pre-set Coloring Mode 

Click an icon among the following icons with pre-set value for VR coloring function. The 
screen will display the image according to the selected mode. 

Icon Item Description 

 
Teeth Tooth mode view 

 
Endo Endo mode view 

 
VR Coloring View the VR coloring graph panel 

 

5.2.1 VR Coloring Graph 

1. VR of VOI View is basically rendered in Endo mode to easily view Root and Canal of tooth.  

2. Right click in VOI View to display context menu. 

 

3. Select VR Coloring menu. Or, select Setting from the pre-set coloring icon. 
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4. VR Coloring Panel is displayed at the bottom of View Frame. 

 

5. Edit VR Coloring graph. Basic function of editing VR Coloring is the same as MPR Tab. 

 

6. Click [Close] button to terminate VR Coloring editing mode. 

5.2.2 Pulp Level Offset 

This is a function to move the CT Range of VR Coloring graph without entering to the VR 
Coloring mode. 

1. Move the Pulp Level Offset slider in VOI Group to adjust the CT Range for the whole graph. 

 

2. The adjusted pulp level applies to VOI view as shown in the following table. 

-500 0 +2000 
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5.3 Displaying Curvature 

This is a function to view curvature of Root Canal in each position. 

1. Select a Root Canal item in Root Canal List. 

 

2. Check Display Curvature check button in VOI group 

 

3. Root Canal Curvature overlay is displayed where the measured value (Curvature Circle 
Radius) is the smallest among the selected Root Canal in VOI view. 

 

4. Curvature can be viewed while moving position by scrolling mouse in VOI View 

 

The circle indicator overlay can be shown/hidden in the Settings. 

▪ Measured position of Curvature is displayed as a point in Root Canal. Drag 
and drop the measured value overlay to the desired place. 

▪ Connection line from measured position to the center of circle is displayed. 

▪ Measured value is displayed on the upper right of the curvature circle, and 
connection line to center of circle is displayed in dotted line. 
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6. Dual Monitor Mode 

6.1 Starting Dual Monitor Mode 

1. Click the [Start Dual Monitor Mode] button in Control Panel. 

 

 

If Ez3D-i fails to detect dual monitors, the [Dual Monitor Mode Start] button will not be 
activated. 

1. Ez3D-i enters Dual Monitor Mode displaying both Main View and Secondary View on each 
monitor. 

  

               Main View          Secondary View 

Dual Monitor Mode does not support following functions: 

▪ Control Panel: Changing Layout 

▪ View Frame: Making a single window by doubling clicking the window title bar to 

▪ Context Menu: Presentation Mode On 

▪ Short Key: <Ctrl + Enter> key 

 

6.2 Exiting Dual Monitor Mode 

Click the [x] icon at the top right corner of the Secondary View to exit Dual Monitor Mode. 
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7. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move images 

 
Zooming Zoom in or out 

 
Length 

Measure the distance between two points on the 
2D image 

 
Capture View Frame Capture the View frame area 

 
Reset View Initialize rotate, move, zoom 

 
Export Save the current image as a file. 

▪ Advanced Tools 

Icons Designation Description of Features 

 

Measurement 

Angle Measure the angle between three points. 

 
Multi Angle Measure multi angle 

 
Multi Length Measure multi length. 

 

Circle 
Measurement 

Measure the radius of inserted circle 

 
Profile Density Profile between two points 

 
ROI 

Measure pixel, average value, maximum 
value and standard deviation of ROI 

 

Capture 

Capture Region Capture the selected area 

 
Capture Window Capture the View Window Area 

 
Multi-Capture Capture multiple images 

 
Create Movie Run the movie capture program. 

 

Annotation 

Pointer Draw freely on the 2D and 3D image. 

 
Free draw Draw freely 

 
Memo Write memos directly on your images 
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Icons Designation Description of Features 

 

On/Off 

Grid Check the scale of the image with grid. 

 

Turn Overlay 
On/Off 

Show / Hide the entire input objects 

 
Show Manager Show / Hide individual input object 

 

Show/Hide 
Patient 

Information 

Show / Hide patient information on the 
image 

 

Sculpt 

Free Sculpt 
Draw freely to select the area to view on 
the VOI view 

 
Polygonal Sculpt 

Draw a polygon to select the area to view 
on the VOI view 

 
Reverse Reverse the sculpted area 

 
Undo Undo your last action 

 
Redo Revert Undo 

 
Reset All Initialize All 

 

Etc 

Data Manager Manage properties of imported data 

 
Delete All Delete all input objects 

 
Initialize All Initialize all changes 

 

 

The following functions cannot be canceled <Esc> Key or with a mouse right click. 

Icons Designation Icons Designation 

 
Reset View 

 
Initialize All 

 
Turn Overlay On/Off 

 
Show Manager 

 
Delete All 

 
Pointer 

 

 

[Create Movie] icon will not appear on the toolbar if the software to link is not 
set. 

The data drawn using the [Pointer] function is not saved to the project file. 

All functions are disabled while the [Pointer] function is in use. 

Use the pointer function to draw on the current screen temporarily. 

Click the [Annotation > Pointer] icon on the tool bar, and then the following 

window appears. 

 

[Pointer]: Drag to draw and mark the area for View Frame. 

[Eraser]: Erase the pointer overlay. The point overlay inserted on the path of the Erase 
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icon moves will be deleted. 

[Thickness]: Set the thickness of Brush or Eraser. 

[Pointer Color]: Set the color of Brush. 

[View Frame Capture]: Capture the View Frame while the pointer drawing mode is on. 

[Reset Pointer]: Delete all pointer objects inserted on the image. 

[Exit]: Close the pointer function. 
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1. TMJ Tab Configuration 

TMJ tab enable users to set the TMJ area and view the cross-sectional images for the clinical 
diagnosis of TMJ. 

Ez3D-i provides the Axial View of TMJ, the Condyle/Fossa images in 3D and the Section 
images, and supports functions to separate the Condyle/Fossa and display the bone density. 

1.1 Workspace 

 

▪ A Section: Right front 3D VR (Volume Rendering) Window  

▪ B Section: Scout Window 

▪ C Section: Left front 3D VR (Volume Rendering) Window  

▪ D Section: Section View window that can view the continuous sectional images, which are 
defined by the navigator of the Scout View and the controller of the Axial View 

 

Based in the FOV size of the image, when the image is in the size of that both TMJ is shown, 
the image is displayed in the layout that the left and the right images appear. Also, when the 
image is in the size of that only one TMJ is shown, the image is displayed in the layout that 

only one side of image appears. 

To view the image in a different layout, click the [Change Layout] button. You can change the 

layout regardless of the FOV size. 

 

  

A C B 

D 

A 



Chapter 8. TMJ Tab  
 

248 Ez3D-i User Manual 

2. Navigator 

The TMJ navigator consists of a frame that indicates the range of the cross-sectional image of 
TMJ area and the TMJ Sectional Line that displays the corresponding cross sectional images. 

   

No Name Description 

A 
TMJ Section Width 

Control Point 

The default size of the frame is 50mm x 50mm, and the size can be 
changed in the [Settings > View > Navigator > TMJ Navigator]. 

The size can be adjusted using the Control Points. 

 

B TMJ Center Line 

It is the Line that designates the range to check the TMJ sectional 
images. The angle between the extension line of the Center Line 
and the Mid Line is the Axial Condylar Angle. 

The TMJ Center line is linked with the Front Image. 

C TMJ Sectional Line 

Section line. It displays and sets the location of Section View, which 
divides the image within the navigator vertically. The angle between 
the extension line of the Sectional Line and the Mid Line is the 
Coronal Condylar Angle. 

D 
TMJ Navigator 
Control Point 

Move the Control Point located on the both sides of the TMJ 
Navigator to adjust the size. 

 

E Midline 

It is the center line of the clinical head, and it acts as guide line 
related to the bilateral symmetry function. It is created on the center 
of the Sagittal direction of the volume. But, the Midline is not 
displayed in the Single TMJ layout. 

▪ The navigator can be displayed or hidden by pressing the <Space Key> on the keyboard. 

▪ Click the Reset Views icon on the tool bar to reset the position and size of TMJ navigator. 

▪ The Box size, which is set when defining TMJ area, does not affect the size of the TMJ 
navigator. 

A 

D B 

C 

E 
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▪ The current position of the navigator and axis can be viewed on the 3D view. 

 

2.1 Moving Navigator 

User can move the Navigator and change the displayed range of the sectional images.  

Drag the inside of the Navigator to change its location. When moving, the size and the position 
of TMJ Sectional Line are maintained. 
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2.2 Moving TMJ Sectional Line 

TMJ Sectional Line displays and sets the location of Section View, which divides the image 
within the navigator vertically. You can move the TMJ Sectional Line to view the sectional 
images of the selected point accordingly. 

Drag and move the Line Indicator. The 2D images change accordingly. 

   

Line Indicator moves while maintaining the interval. The interval and thickness can be changed 
in the Settings. 
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3. VR Coloring Group 

The VR Coloring Group consists of the functions to set the VR Coloring and to display the 
segmented Condyle/Fossa. 

3.1 Showing Condyle/Fossa 

The VR Coloring Group provides the function to show or hide the Condyle/Fossa.  

The checkboxes of the Condyle and the Fossa options are segmented and selected 
automatically. 

▪ When both Condyle/Fossa are selected 

 

 

▪ When only Condyle is selected 
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▪ When only Fossa is selected 

 

 

 

 

When the TMJ information of the DICOM header is incorrect or missing, the Segmentation 
will not be done properly. In this case, user must redefine the location of the Condyle Head 
using [Define TMJ Area]. 

 

3.2 VR Coloring 

The image coloring is optimized with the rendering value that the user has chosen. 

 

Only the Teeth, Bone, and the MIP mode are supported. 

When only one of the Condyle or Fossa is selected, the VR coloring is set to the Bone mode, 

and the user cannot use the Teeth and the MIP mode. 

When changing the Condyle/Fossa option while the Teeth or the MIP modes are selected, the 
mode changes to the Bone mode automatically and the previous condition is not saved. 
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4. Defining TMJ Area 

It is to set the height to check with the TMJ area and the standard point for the TMJ 
Segmentation (segmentation of Condyle/Fossa). 

1. Click the [Define TMJ Area] button. A window appears to select the area. 

 

2. Drag the Area Selection line to adjust the position in the Front and the Left view. 

 

3. Drag the Condyle Head Position to the Condyle center in the Condyle Head Position View 

 

 

▪ The accurate Condyle position will increase the accuracy of the TMJ 
Segmentation. 

▪ Use the mouse wheel to view the previous and the next Axial images in the 

Condyle Head Position View 

▪ The movable range for Slice is within the TMJ area that is set in the front and the 
side view. 

▪ Condyle Head Position function and the TMJ navigator are not synchronized. 

▪ The number of the Condyle Head Position is determined according to the view 
frame layout. 

▪ Vertical: Set the width of the Left/Right direction to check in the 3D format after 

the Segmentation. 

▪ Horizontal: Set the width of the Front/Back direction to check in the 3D format 
after the Segmentation. 
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4. Check the selected area in the front and the side view and the Condyle Head Position 
image, and then click the [OK] button. The [Define TMJ Area] window is closed and the TMJ 
area of the selected area is displayed.  
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5. Bone Density 

The bone density of selected cross-sectional images can be checked. 

In the Windowing Group, click the [Bone Density] Button to display all 2D images in the Bone 
Density mode. Move the slider at the bottom of the screen to change the Sectional image 
position. 

 

 

 

Adjusting bone density range depending on the equipment that you have is required to use 
the bone density function more accurately. (There are many cases where CBCT has 
different CT Number values, which are the standard of bone density standard, depending 
on the equipment.) 

Users should be aware of this limitation before diagnosing and performing simulation 
according to the bone density value. The treatment based on the incorrect measurement 
may cause failure in operation or complications. 

 

Because the CT Number can be different by acquisition equipment, the values can be set 
according to the user's equipment in the Settings. Bone density area (D1 - D5) can be 
changed to appropriate CT Number based on the user's acquisition equipment in the 
[Settings > Simulation > Bone Density > Bone Density Area], and the color can be changed. 

  



Chapter 8. TMJ Tab  
 

256 Ez3D-i User Manual 

6. Clipping 

The Clipping function is to cut a 3D image in the selected direction to view the cross-sectional 
image. 

1. Click the [Apply Clipping] button to execute clipping function. 

 

2. Click to select the direction to clip a 3D image. 

  

3. Click the combo box to set the area for clipping. 

 

4. Drag the slider and the image will be clipped in the selected direction. 

 

 

The Clipping function is applied to the 3D images on the left and the right at the same time. 

To reset the clipping, click the [Reset Clipping] button. 
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7. Changing Section View Thickness and Interval 

The thickness and interval of the Section View, which displays the cross-sectional images where 
the navigator is located, can be changed. 

▪ Changing Thickness 

1. Click the right mouse button on the cross-sectional view pane. 

2. Click the [Thickness] option and select the thickness from the expanded list. The 
selected thickness will be applied to all cross-sectional images. 

 

▪ Changing Interval 

1. Click the right mouse button on the cross-sectional view pane. 

2. Click the [Interval] option and select the interval from the expanded list. The selected 
interval will be applied to all cross-sectional images. 
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8. Dual Monitor Mode 

8.1 Starting Dual Monitor Mode 

1. Click the [Start Dual Monitor Mode] button. 

 

 

If Ez3D-i fails to detect dual monitors, the [Dual Monitor Mode Start] button will not be 
activated. 

2. Ez3D-i enters into the Dual Monitor Mode displaying both Main View and Secondary View 
on each monitor. 

 

               Main View          Secondary View 

Dual Monitor Mode does not support following functions: 

▪ Control Panel: Changing Layout 

▪ View Frame: Making a single window by doubling clicking the window title bar to 

▪ Context Menu: Presentation Mode On 

▪ Short Key: <Ctrl + Enter> key 

 

8.2 Exiting Dual Monitor Mode 

Click the [x] icon at the top right corner of the Secondary View to exit Dual Monitor Mode. 
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9. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move images 

 
Zooming Zoom in or out 

 
Length 

Measure the distance between two points on the 
2D image 

 
Capture View Frame Capture the View frame area 

 
Reset View Initialize rotate, move, zoom 

 
Export Save the current image as a file. 

▪ Advanced Tools 

Icons Designation Description of Features 

 

Measurement 

Angle Measure the angle between three points. 

 
Multi Angle Measure multi angle 

 
Multi Length Measure multi length. 

 

Circle 
Measurement 

Measure the radius of inserted circle 

 
Profile Density Profile between two points 

 
ROI 

Measure pixel, average value, maximum 
value and standard aviation of ROI 

 

Capture 

Capture Region Capture the selected area 

 
Capture Window Capture the View Window Area 

 
Multi-Capture Capture multiple images 

 
Create Movie Run the movie capture program. 

 

Annotation 

Pointer Draw freely on the 2D and 3D image. 

 
Free draw Draw freely 

 
Memo Write memos directly on your images 
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Icons Designation Description of Features 

 

On/Off 

Grid Check the scale of the image with grid. 

 

Turn Overlay 
On/Off 

Show / Hide the entire input objects 

 
Show Manager Show / Hide individual input object 

 

Show/Hide 
Patient 

Information 

Show / Hide patient information on the 
image 

 

Etc 

Data Manager Manage properties of imported data 

 
Delete All Delete all input objects 

 
Initialize All Initialize all changes 

 

 

The following functions cannot be canceled <Esc> Key or with a mouse right click. 

Icons Designation Icons Designation 

 
Reset View 

 
Initialize All 

 
Turn Overlay On/Off 

 
Show Manager 

 
Delete All 

 
Pointer 

 

 

▪ [Create Movie] icon will not appear on the toolbar if the software to link is not set. 

▪ The data drawn using the [Pointer] function is not saved to the project file. 

▪ All functions are disabled while the [Pointer] function is in use. 

▪ Use the pointer function to draw on the current screen temporarily. 

▪ Click the [Annotation > Pointer] icon on the tool bar, and then the following window 

appears. 

 

 [Pointer]: Drag to draw and mark the area for View Frame. 

 [Eraser]: Erase the pointer overlay. The point overlay inserted on the path of the Erase 
icon moves will be deleted. 

 [Thickness]: Set the thickness of Brush or Eraser. 

 [Pointer Color]: Set the color of Brush. 

 [View Frame Capture]: Capture the View Frame while the pointer drawing mode is on. 

 [Reset Pointer]: Delete all pointer objects inserted on the image. 

 [Exit]: Close the pointer function. 
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1. ORTHO Tab Configuration 

ORTHO Tab provides orthodontic simulation function using 3D Photo and segmented data from 
CT including Bone model and Tooth model data. The Predict Soft Tissue feature enables you to 
predict how the treatment plan established may affect the face of a patient. In addition, the 
Comparison enables you to establish a treatment plan by comparing photos before and after the 
treatment. 

 

All functions on the ORTHO Tab are available only when there exists segmented DATA 
(3D Photo, Bone Model, Tooth Model Data). Please complete tooth segmentation or 
import segmented data on the SEGMENT Tab before using functions on ORTHO Tab. 

The following error message appears when entering Endo Tab without Segmentation 
result, and Orth Tab is maintained as black after clicking [Close] button 

 

1.1 Workspace 

 

A Section: Simulation Window 

B Section: Prediction Window 

 

 

A B 
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2. Calibrate Soft Tissue 

Calibrate Soft Tissue function enables users to input four landmarks that are required to conduct 
Predict Soft Tissue function.  

1. Click the [Calibrate Soft Tissue] button in the 3D PHOTO group. 

 

 

■ Pop-up Message Handling 

When there exists no 3D Photo in Data 
Group. 

 

1. Click the [Close] button 

2. Go to [MAIN MENU > Import > 3D 
Photo] 

3. Register the imported 3D Photo. 

 

* Please refer to ‘Chapter 1. Ez3D-i Basics 
> 5.7.2 Import 3D Photo’ 

When 3D Photo in Data Group is not 
registered yet. 

 

1. Click the [Yes] button. 

2. The Registration Dialog 
automatically papers. 

 

* Please refer to ‘Chapter 1. Ez3D-i Basics 
> 5.7.2 Import 3D Photo’ 

Where Soft Tissue calibration is already 
done. 

 

1. Click the [OK] button to re-calibrate 
soft tissue or click the [Cancel] button 
to use the existing points without 
recalibration. 

2-1. [OK]: Proceed next step. 

2-2. [Cancel]: Skip the calibration 
process. 

 

2. The [Calibrate Soft Tissue] dialog appears. 

 

 

E 
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3. Click the [Point insert] icon in the toolbar. 

 

4. The [Landmark List] on the left part of the dialog will show the list of landmarks to be 
inserted and a guide image to follow. Click the corresponding position where the guide 
image is showing on the insert view image.  

 

Please follow the guide image and the order of landmarks shown on the list. 

4-1. ANS  

  

4-2. Right Cheilion  
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4-3. Left Cheilion  

  

4-4. Lower Cheilion 

  

5. Click the [OK] button on the bottom of the dialog after completing inserting all landmarks. 
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3. Treatment Simulation 

The user can add treatment plans to the list of TREATMENT SIMULATION. Each treatment 
includes the structure of object tree, result of object simulation (moving, rotating) and bone 
cutting. 

 

3.1 Select Treatment 

1. Click one of the treatment on the list to select. 

 

2. The bone data, tooth data and 3D photo included in selected treatment are displayed on 
the view. 
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3.2 Add Treatment 

1. Click the [Add Treatment] button.  

 

2. Click [New] button in the following dialog to continue. 

 

3. [Add Treatment] dialog appears. 

 

4. Input Treatment Name and select a file name from Data Group. 

 

5. Click the [Orthognathic Surgery] button when bone segmentation is required. 

 

Please refer to ‘Chapter 9. ORTHO Tab > 4. Bone Segmentation’. 

6. Click the [OK] button to complete. 

7. The inserted treatment is added to the list of TREATMENT SIMULATION. 
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3.3 Copy and Add Treatment 

The Clipping function is to cut a 3D image in the selected direction to view the cross-sectional 
image. 

1. Click one of the treatment on the list to copy. 

 

2. Click the [Add Treatment] button. 

 

3. Click OK in the following dialog to continue. 

 

4. The following Orthognathic Surgery dialog appears 

 

5. Modify the defined treatment name. 

 

Please note that users cannot change Data Group as it is disabled when selecting [Copy 
and Add treatment]. 

6. Click the [OK] button to complete.   
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7. The inserted treatment is added to the list of TREATMENT SIMULATION. 

 

 

3.4 Modify Treatment 

1. Click one of the treatment to modify on the list and right click on the treatment name. 

 

2. Select [Modify]. 

 

3. Change Treatment Name in [Treatment Property] dialog. 

 

4. Change Data Group and click the [OK] button. 

 

5. Click OK button to update the treatment on the list. 
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3.5 Delete Treatment 

1. Click one of the treatment to delete on the list and right click on the treatment name. 

 

2. Select [Delete]. 

 

3. Click [OK] to confirm to delete the treatment from the list. 

  

4. The selected treatment is deleted from the list. 
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4. Bone Segmentation 

Bone segmentation function is to segment a bone model for orthognathic surgery according to 
user defined cutting lines and save the result as a STL file format.  

1. A default item is automatically created in TREATMENT SIMULATION list when there exists 
tooth segmentation data.  

 

2. Select [Orthognathic Surgery] button for bone segmentation. 

 

3. The [Orthognathic Surgery] dialog appears. 

 

4. Select a data option on the Cutting View. 

 

5. Select a direction on the Cutting View. 

 

6. Click the Cutting Line icon  or Cutting Multi Line icon  on the toolbar.  

 

 

Click the Reset All icon to delete all the inserted cutting lines. 
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7. Draw line or Multi Line on the Cutting View 

▪ Line 

Click on two points (start and end point) on the Cutting View. 

 

▪ Multi Line 

Click muliple points and doulbel-click at the last points on the Cuttin View. Then the 
image will be devided into two area based on the inserted mult-line 
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8. The inserted cutting path will be added to the Cutting Path List and shown in the Preview 
on the right. 

 

9. You can add multiple cutting paths by repeting to select data option, select direction and 
draw cutting line. 

 

10. Press the [OK] button on the button to apply the cutting paths. 

 

11. Please wait until the bone segmetation process is completed. 
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12. The scrren is back to the [Treatment Simulation] dialog when bone cutting is done. 

 

13. Click the [OK] button to complete adding treatment and display the segmented result on the 
screen. 
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5. Object Simulation 

The OBJECT group manage bone model and tooth model. It shows bone models and tooth 
models on the model object list in a tree structure. This list of objects enables users to choose 
an object from the list so that they can move and rotate the selected object with a controller. 

1. Select one treatment simulation from the list. 

 

2. Select the object from the OBJECT list by clicking the model name.  

 

3. The user can change the properties (Show/Hide, Lock/Unlock) of each object by ticking the 
check box. Please noe that the locked object cannot be moved. 

4. A controller appears at the center of the selected objects in the SIMULATION view. 
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5. Change the direction and location of the image by using the controller. 

▪ Moving 

Drag & drop the inner circle area of the controller or use the direction keys on the 
keyboard to move the object. 

   

         [Before]                                [After] 

▪ Rotating 

Drag & drop outer ring of the controller or use up & down direction keys on the 
keyboard to rotate the object. 

   

        [Before]                                [After] 
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6. Predict Soft Tissue 

 

The Predict Soft Tissue function is a simulation to predict patient's facial condition after 
surgery. The actual result may vary on a person-to-person basis. 

The user must be aware of the limits of simulation and should carefully proceed one’s 
treatment planning. 

3D Photo, Bone model and Tooth model data should be imported and registered in advance. 
Also, four landmarks are required to be input by a user before starting to predict soft tissue.  

Please refer to ‘Chapter 9. ORTHO Tab > 2. Calibrate Soft Tissue’ for more information about 
Calibrate Soft Tissue. 

1. Select a treatment from the TREATMENT SIMULATION list. 

 

2. Click the [Predict Soft Tissue] button in the 3D PHOTO group. 

 

3. The following progress bar appears on the screen. 

 

4. The result of Predict Soft Tissue is shown on the PREDICTION View. 
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7. Comparison 

The Comparison button in the MODE group is show before and after image of Predict Soft 
Tissue simulation at the same time to help users see the difference comparing the Initial and 
Prediction view. 

1. Click the [Comparition] button in the MODE group. 

 

2. The layout is changed to compare the initial 3D photo and prediction result of the 3D photo 
image. 
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8. The layout Opacity settings 

The following images show how the image changes according to opacity settings. 

 3D Photo Bone Tooth 
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Users can adjust data opacity in the range between 0 and 100 (1 interval) by controlling slides 
in OPACITY group. 
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9. Change Layout 

There are two layouts available on ORTHO Tab. 

▪ 1+1(Simulation View+ Prediction Result View) 

▪ 2+1(Simulation Maxilla View + Simulation Mandible View + Prediction Result View) 

By clicking the [Change Layout] button, the current layout can be changed to the other layout. 

1. The default layout consists of SIMULATION and PREDICTION view is shown as follows. 

 

2. Click the [Change Layout] button. 

 

3. Then the SIMULATION View is divided into MAXILLA and MANDIBLE view. 

 



Chapter 9. ORTHO Tab 
 
 

Ez3D-i User Manual 283 

10. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move images 

 
Zooming Zoom in or out 

 
Length 

Measure the distance between two points on 2D 
images 

 
Capture View Frame Capture the View frame area 

 
Reset View Initialize rotate, move, zoom 

 
Export Save the current image as a file. 

▪ Advanced Tools 

Icons Designation Description of Features 

 
Measurement Angle Measure the angle between three points. 

 

Capture 

Capture Region Capture the selected area 

 
Capture Window Capture the View Window Area 

 
Create Movie Run the movie capture program. 

 
Annotation Pointer Draw freely on the 2D and 3D image. 

 

On/Off 

Grid Check the scale of the image with grid. 

 
Show Manager Show / Hide individual input object 

 

Turn Overlay 
On/Off 

Show / Hide the entire input objects 

 

Show/Hide Patient 
Information 

Show / Hide patient information on the image 

 

Etc 

Data Manager Manage properties of imported data 

 
Delete All Delete all input objects 

 

Initialize 
Treatment 

Initialize all changes except tree structure and 
bone segmentation from the current treatment  
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The following functions cannot be canceled <Esc> Key or with a mouse right click. 

Icons Designation Icons Designation 

 
Reset View 

 
Initialize Treatment 

 
Turn Overlay On/Off 

 
Show Manager 

 
Delete All 

 
Pointer 

 

 

 

▪ [Create Movie] icon will not appear on the toolbar if the software to link is not set. 

▪ The data drawn using the [Pointer] function is not saved to the project file. 

▪ All functions are disabled while the [Pointer] function is in use. 

▪ Use the pointer function to draw on the current screen temporarily. 

▪ Click the [Annotation > Pointer] icon on the tool bar, and then the following window 

appears. 

 

 [Pointer]: Drag to draw and mark the area for View Frame. 

 [Eraser]: Erase the pointer overlay. The point overlay inserted on the path of the Erase 
icon moves will be deleted. 

 [Thickness]: Set the thickness of Brush or Eraser. 

 [Pointer Color]: Set the color of Brush. 

 [View Frame Capture]: Capture the View Frame while the pointer drawing mode is on. 

 [Reset Pointer]: Delete all pointer objects inserted on the image. 

 [Exit]: Close the pointer function. 

 



Chapter 10. SEGMENT Tab 
 
 

Ez3D-i User Manual 285 

Chapter 10. SEGMENT Tab 

1. SEGMENT Tab Configuration .................................. 287 

2. Quick Segmentation ................................................ 288 

3. Import Segmentation Data ...................................... 290 

4. Segmentation List .................................................... 291 

5. Object List ................................................................ 292 

6. Label Object ............................................................. 294 

7. Add Object ................................................................ 296 

8. Manual Segmentation .............................................. 297 

9. Tools in the Toolbar ................................................. 301 
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1. SEGMENT Tab Configuration 

Segmentation function is to segment image into bone data (including Maxilla and mandible) and 
each tooth data as separate objects to be used during simulation such as tooth extraction and 
Predict Soft Tissue.  

Teeth segmentation data and Bone segmentation data is required to conduct orthognathic 
simulation on the ORTHO Tab. Please conduct segmentation function or import segmentation 
data on the SEGMENT Tab before using functions on the ORTHO Tab.  

SEGMENTATION tab enables users to conduct teeth segmentation and bone segmentation or 
import segmented data as well as to manage segregated data. Also, users can manage objects 
included in each segmentation group through list of segmentation groups and list of objects as 
well as change tooth code by using Label Object function. 

1.1 Workspace 
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2. Quick Segmentation 

 

Quick Segmentation is a simulation function to separate individual teeth from CT data. Its error 
range is ±10%. Users must be aware of and carefully consider the error range when consulting 
a patient. This function is not intended for actual surgery planning but for patient consultation 
only. 

 

Teeth Segmentation and Bone segmentation are only available for User group. 

2.1 Teeth Segmentation 

1. Select a segmentation group and click [Teeth Segmentation]. 

 

2. When the following dialog appears, click OK to conduct Teeth Segmentation again, or 
Cancel to maintain previous segmentation results.  

 

3. Please wait until segmentation process is completed. 

 

4. The result of Teeth Segmentation is shown on the 3D View. 
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2.2 Bone Segmentation 

1. Select a segmentation group and click the [Bone Segmentation] button. 

 

 

Bone segmentation is enabled after Teeth Segmentation is completed and only when it is 
available for the User group.  

2. When the following dialog appears, click OK to conduct Teeth Segmentation again, or 
Cancel to maintain previous segmentation results.  

 

3. Move the slider to set the CT number threshold and click [OK] to proceed. 

 

4. When the segmentation is complete, the result of Bone Segmentation is shown on the 3D 
View. 
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3. Import Segmentation Data 

1. Click the [Import] button in the SEGMENTATION group. 

 

2. Select a file directory to import and click the [OK] button. 

 

▪ Only zip files are available to be chosen and multi file selection is not supported. 

3. Please wait until import process is completed. 

 

4. Click the [Close] button when the following message appears. 

 

5. The imported file is added to the SEGMENTAION list with a name automatically created. 
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4. Segmentation List  

4.1 Set as Default Group 

The user can set the default group by clicking the Default radio button. 

 

 

When the default group is changed, all changes made to tooth segmentation data will be lost. 

4.2 Modify/ Delete 

1. Click a segmentations group on the list and right click on the segmentation group name. 

2. Select Modify/ Delete. 

 

 

When a segmentation group is deleted, all orthognathic treatment included in the segmentation 
group will be lost as well. 
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5. Object List  

5.1 Select an Object 

1. Click on of the segmentation group from the SEGMENTATION list. 

 

2. Click an object on the list. 

 

3. The selected object will be shown as selected in a different color on the 3D View. An object 
can also be selected by clicking on the view. 
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5.2 Show/Hide Objects  

1. Select a segmentation group on the list. 

 

2. Check/uncheck the check boxes on the right of each object to show/hide objects on screen. 

 

3. The unchecked objects will be hidden. 
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6. Label Object 

6.1 Modify Labels of Objects  

1. Click on of the segmentation group from the SEGMENTATION list. 

 

2. Click an object on the list. 

 

3. Click the [Label Objects] button. 

 

4. The [Label Objects] dialog appears as follows. 

  

 

Maxilla and Mandible buttons are disabled when Maxilla and Mandible objects already exist 
to prevent duplication. 
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5. Select a desired label button to change current label to and click the [OK] button. 

 

6. The labels of objects are automatically updated. 
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7. Add Object 

7.1 Creating object with manual segmentation 

1. Click on of the segmentation group on the list. 

  

2. Click Add Object button. 

  

3. Select a label of the object to add, and click OK. 

  

4. [Manual Segmentation] dialog appears. 

  

5. Please refer to ‘Chapter 10. SEGMENT Tab > 8. Manual Segmentation’ to complete 
manual segmentation. 

6. Exit Manual Segmentation dialog to display the results on the screen. 
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8. Manual Segmentation 

8.1 Start Manual Segmentation 

1. Click on of the segmentation group from the SEGMENTATION list. 

 

2. Select an object to conduct manual segmentation from the OBJECT LIST. 

 

3. Click Manual Segmentation button. 

 

4. Manual Segmentation dialog appears. 
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8.2 Object Labelling 

1. Check the current object label. 

  

2. Click Change Label if it needs to be changed. 

3. Label Objects dialog appears. 

  

4. Select an object to change to and click OK. 

5. The changed label applies when End Manual Segmentation button is clicked. 

 

8.3 Masking 

1. Masking button is enabled as default when Manual Segmentation dialog appears. 

  

2. Select a brush in the BRUSH group. 

  

 

 

 

 

 

 

 

 

 

 
Sphere Brush Tool to insert mask with sphere-shaped brush 

 
Circle Brush Tool to insert mask with circle-shaped brush 

 
Sphere Eraser Tool to delete mask with sphere-shaped eraser 

 
Circle Eraser Tool to delete mask with circle-shaped eraser 

 
Size Tool to change the size of brush and eraser 
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3. Select a threshold type and range. 

  

Smart Threshold 
Mask with threshold value of seed area 

(circle or sphere area where mouse-clicked) 

 

 

Threshold Mask with threshold range set in the Threshold Slider 

 

 

4. Click and drag in the image panel to conduct masking function. 
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8.4 Filling Between Slices 

1. Click Fill Between Slices button . 

  

2. Apply Fill between Slices button is enabled and the workspace enters into Fill Between 
Slices mode. 

  

3. Select a view to insert mask. 

4. Select a brush or erase to draw on each slice on 2D view. 

5. Click Apply Fill between Slices button after completing drawing. 

  

6. Volume mask connecting more than two masks is created. 
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9. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move images 

 
Zooming Zoom in or out 

 Grid Check the scale of the image with grid. 

 
Reset View Initialize rotate, move, zoom 

 
Export Save the current image as a file. 

 

▪ Advanced Tools 

Icons Designation Description of Features 

 
Show Bounding Box Display bounding box of mask volume of 3D view 

 
Undo Undo your last action 

 
Redo Revert Undo 

 
Reset All Initialize Sculpt 

 
ROI 

Measure pixel, average value, maximum value 
and standard deviation of ROI 

 
Smoothing Rounding edges of masking volume data 
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▪ [Undo]: Function to undo masking result. 

▪ [Redo]: Cancel Undo function. It is possible to redo each step of undo results.  

▪ [Reset All]: Function to initialize all masking results. The following message pops up when 

selecting Reset All button. When OK is clicked, all masking data is deleted, and it returns to 
the initial status. 

 

▪ [ROI]: Function to set region and create volume measure with the set threshold value. The 
following ROI Mask dialog appears when ROI tool icon is clicked. Select Masking Type, 
Intensity (Threshold vale applied to the selected ROI), View Mode only check box if needed, 
and click OK button to apply changes. 

 

▪ [Smoothing]: Function to apply rounding effect to masked volume data. A pop-up dialog 

appears to set smoothing size when selecting Smoothing tool icon. Move the slider to adjust 
smoothing value and click OK to apply the change. 
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Chapter 11. CONSULT Tab 

1. CONSULT Tab Configuration .................................. 305 

2. Selecting Consulting Images in the Cart ............... 306 

3. Consult Contents ..................................................... 307 

4. Editing Cart ............................................................... 310 

5. Tools in the Toolbar ................................................. 318 
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1. CONSULT Tab Configuration 

The CONSULT Tab allows users to manage the image data necessary for counseling patients 
by organizing images into carts depending on the treatment category. 

Ez3D-i can add, edit and delete the images in the cart as desired for patient counseling. 

1.1 Workspace 

 

▪ A is Consult Content screen. It shows the list of videos and images for patient counseling 
Drag & drop one of the videos then it is automatically played. 

▪ B is the Captured Image screen. The image captured by the user in other tabs is displayed. 

▪ C is the screen showing the consult content. The user can drag and drop to play the videos 
and images in the list above for patient consultation. 

 

Right click the captured images in the B window to delete or save it with different name. 

Also, the captured images in the thumbnail list can be added to the workspace, and the image 

on the workspace can be added to the Consult Image by right clicking the image. 

Multi captured images cannot be viewed in the Report tab. 

 

If operating system of user’s PC is Windows 7 edition and Media Player has not installed yet, 
video for consultation does not play. 

Please visit http://windows.microsoft.com, download Media Player 12 and install it. 

In the Windows vista environment, the consultation video will not be played. 

  

A 

B C 
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2. Selecting Consulting Images in the Cart 

[Favorites] category includes the user’s preferred consultation videos. 

[Recent List] includes the user’s most recently used consultation videos. 
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3. Consult Contents 

User can add captured images and consult contents to view frame for consultation. 

 

For the patients who have the same Patient ID, categories by acquisition date is created in 
the [CAPTURED IMAGES] list below the main menu, and the images in each category 
appear in the thumbnail list. 

3.1 Adding Consult Image 

User can add captured images as consult contents. 

1. Right click image in the [CAPTURE] window and click the [Add Consult Image] option. The 
[Consult Editor] dialog appears. 

 

2. Click to select a category to where the image is added. Or click the [Create] button to 
create a new category. 

 

3. Click the [OK] button. The image is added to the selected category. 
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3.2 Adding Consult Contents 

Drag and drop the image and consult content from the thumbnail view to the view frame. 

 

 

3.3 Playing Movie Clip 

User can add consult contents such as movie clip to view frame and play for more efficient 
consultation. 

Drag and drop the movie clip to the view frame. The control bar appears at the bottom of the 
Consult pane. 
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3.4 Adding to Favorite 

Right click on the Consult pane and click the [Add Favorite] option. The content will be added to 
the [Favorites] category. 

 

 

3.5 Viewing Property 

Right click on the Consult pane and click the [Property] option to view the information of 
corresponding content. The [Consult Editor] dialog appears. 
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4. Editing Cart 

Users can add, change and delete categories in the cart. Within a category, the user can add 
new content or create a new folder. 

 

The [Favorites] category cannot be modified or deleted. 

4.1 Adding New Category 

1. Click the [Open Editor] button. The [Consult Editor] window appears. 

 

2. Click and select the category to add to a sub-category. 

 

3. Click the [Create] button. The [Add Category] window appears. 
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4. Enter the name of the category and then click the [OK] button to create the category. 

 

5. The word "(User)" will be added to the category created by user. 
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4.2 Modifying Category 

1. Click the [Open Editor] button. The [Consult Editor] window appears. 

 

2. Click and select the category you wish to modify. 

 

3. Click the [Modify] button. The [Modify Category] window appears. 

 

4. Enter the new name of the category and then click the [OK] button to change the name. 
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4.3 Deleting Category 

1. Click the [Open Editor] button. The [Consult Editor] window appears. 

 

2. Select the category you wish to delete and then click the [Delete] button. 

 

3. The following [DELETE] window appears to confirm the deletion. Click the [Yes] button. The 
category is deleted. 

 

 

4.4 Adding Contents 

1. Click the [Open Editor] button. The [Consult Editor] window appears. 
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2. Select the category to add new contents, and then click the [Add Contents] button. 

 

3. The following Select Content window appears. Click the content to add and then click the 
[Open] button. Image format (*.bmp, *.jpg, *.png), video format (*.avi, *.mov, *.mp4, *.wma), 
and document format (*.doc, *.docx, *.ppt, *.pptx, *.pdf) can be added. 

 

4. The added contents appear in the [Preview] window. The name of the contents can be 
changed in the [Image Name] field. 

 

 

When opening the document format contents, the file will not be opened with Ez3D-i, but the 
relevant program will be executed to open the file. 

Contents cannot be added to the Basic category and the categories that have sub-categories. 
Users can only add contents to the categories that are added by user and that do not have 
sub-categories. 
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4.5 Deleting Contents 

1. Click and select the category that includes the contents to delete. 

 

2. Right click the contents to delete and click the [Delete] option. 

 

3. Click the [OK] button to confirm the deletion. The selected contents will be deleted. 
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4.6 Adding Content Folder 

1. Click the [Open Editor] button. The [Consult Editor] window appears. 

 

2. Select the category to add a content folder. Click the [Add Content Folder] button. 

 

3. Select the folder to add in the [Select Directory] dialog. 

 

4. Click the [Select Folder] button. The added folder appears. 
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4.7 Coping Consult Image 

User can copy consult image to the categories added by user. 

1. Click the category that has the image to copy. The images in the selected category are 
displayed in the Preview pane. 

2. Click the image in the image list, and drag and drop it to the category to where the image is 
copied. 

 

 

The image can be copied only to the categories added by users, and if the category has sub-
categories, it cannot be copied to the main (upper) category. 
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5. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Panning Move the image 

 
Zooming Zoom in or out 

 
Pointer Draw freely 

 
Save to DB Save the selected image in the database. 

 
Capture Region Window capture 

 
Capture Window Capture the View Window area 

 
Grid Check the scale of the image with grid. 

 
Reset View Reset panning and zooming 

 

 

Save to Database 

The [Save to DB] icon is enabled only when the [Captured image save option] is set to 
[Manual save to image server] and run through the linked EzDent-i. 

The option will not be enabled if either condition is not satisfied. 

 

▪ The point overlay remains even when showing in the Full Screen mode or the 
[Pointer] function is terminated in the Consult tab. But, the point overlay will be 

deleted when loading other images or closing the program. 

▪ When capturing images with the [Capture Region] and the [Capture Window] 
function, the images are not saved to the DB. 

▪ The data drawn using the [Pointer] function is not saved to the project file. 

▪ All functions are disabled while the [Pointer] function is in use. 

▪ Use the pointer function to draw on the current screen temporarily. 

▪ Click the [Annotation > Pointer] icon on the tool bar, and then the following window 
appears. 

 

 [Pointer]: Drag to draw and mark the area for View Frame. 

 [Eraser]: Erase the pointer overlay. The point overlay inserted on the path of 
the Erase icon moves will be deleted. 

 [Thickness]: Set the thickness of Pointer or Eraser. 

 [Pointer Color]: Set the color of Pointer. 

 [View Frame Capture]: Capture the View Frame while the pointer drawing 
mode is on. 

 [Reset Pointer]: Delete all pointer objects inserted on the image. 

 [Exit]: Close the Pointer function. 
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1. Starting Report Dialog 

Report dialog allows users to keep diagnosis and counseling records. It can be used as a chart 
to record images of patient and treatment description. 

Ez3D-i can send the report to the patient directly via email as a PDF file. 

1. Click Report button at the bottom left of control panel. 

 

 

Repot button is displayed on all diagnosis tabs except Segment and Consult tab. 

2. Report dialog appears as follows. 

 

3. Please wait until loading progress is completed. 

 

4. When Loading Progress is completed, Change Template Dialog pops up to select a report 
template to open.  
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5. Default template is opened on the workspace of Report dialog and images are displayed on 
the image boxes when Auto Fill option is enabled. 

 

 

Please refer to ‘Chapter 12. Report > 3.4 Inserting Images’ for more information about 
how to fill image boxes with captured images. 
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2. Report Dialog Layout 

 

▪ A: Control Panel 

- Show list of templates 

- Add pages and item boxes  

- Print/Save/Open report 

▪ B: Workspace 

- Display template title 

- Display report template 

- Display image on the report 

▪ C: Tool bar 

- Display tools to be used in the Workspace 

▪ D: Captured Image 

- Display image thumbnails to select and insert in the report 

  

A 
B 

C 

D 
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3. Editing Report 

3.1 Updating Image 

1. Click Update Image button to update image boxes with current images on diagnosis tab. 

 

 

Please click Update Image button when a report is opened. 

2. Images are updated according to Auto Fill setting. 

▪ If the property of image box is set as ‘Auto Fill’, the image is updated.  

▪ If the property of image box is set as ‘Captured’, the image is not updated.  

 

3.2 Managing Report Page 

 

 

3.2.1 Changing Page 

▪ [◀] button is to view previous page. The button is disabled when it reaches the first page. 

▪ Page Number is to show current page/total page 

▪ [▶] Button is to view next page. The button is disabled when it reaches the last page. 

3.2.2 Adding Page 

1. Click Add Page button to add a page to the selected report. 

   

2. A new blank page is added to the last page. 

 

Pages can be added up to 10.  
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3.2.3 Deleting Page 

1. Click Delete Page button to delete a page which is currently displaying on the report. 

  

2. Click OK to delete when the following message appears. 

  

3. The page is deleted and the previous page is displayed. 

 

3.3 Adding/Deleting Item Box 

3.3.1 Adding Single Image Box 

1. Select Insert Image Box button to create an image box on the selected report. 

  

2. A single image box is inserted on the default position in default size. 

  

3. Drag and drop the inserted image box to move to the desired position. Or resize the image 
box by using the control point. 
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4. Right click while selecting image box to show context menu. You can edit or delete image 
as well as copy or delete image box by clicking each item on context menu. 

 

 

Edit Image option is only enabled when Auto Fill option is enabled. This function 
is used to change auto fill image.  

3.3.2 Adding Multi Image Box 

1. Select Multi Image Box button to create an image box on the selected report. 

 

2. Select number of rows and columns of tables when Image Box dialog appears and click 
OK. 
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3. Image box is created with the selected number of tables. 

 

 

Reference Guide Image boxes are display above Multi Image Box. Property of 
each Reference Guide Image can be changed, and property is initialized when 
Reference Guide Image Box is hidden. 

4. Drag and drop the inserted image box to move to the desired position. Or resize the image 
box by using the control point. 

5. Right click while selecting image box to show context menu. You can edit or delete image 
as well as copy or delete image box by clicking each item on context menu. 

 

 

Edit Image option is only enabled when Auto Fill option is enabled. This 
function is used to change auto fill image.  

3.3.3 Adding Text Box 

1. Click Insert Text Box button to a text box on the selected report. 
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2. A text box is created on the default position in default size. 

  

3. Drag and drop the inserted text box to move to the desired position. Or resize the text box by 

using the control point. 

4. Right click while selecting text box to show context menu. You can copy or delete image box 

by clicking each item on context menu. 

 

5. Double click text box to input or edit text. 

6. Right click on Text Input Mode to display context menu and click desired preset comment to 

input in the textbox.  
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3.3.4 Deleting Item Boxes 

1. Select an Item Box on the workspace of the report. 

 

2. Click Delete button on the ITEM option. 

  

3. The selected item is deleted from the workspace. 

  

 

  

 

Item boxes can also be deleted by... 

Short Cut Key: Select Item Box + Delete Key 

Context Menu: Select Item Box > Right-click > Select Delete on the context menu 
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3.4 Inserting Images 

3.4.1 Inserting Single Captured Image 

1. Select captured CT data to insert. 

 

2. Click a thumbnail of image to insert. 

3. Drag and drop the selected thumbnail on the desired image box. 

4. The selected image is shown in the image box. 

 

3.4.2 Inserting Multi Captured Image 

1. Select captured CT data to insert. 

 

2. Click a thumbnail of image to insert. 

3. Drag and drop the selected thumbnail on the desired image box. 

4. Select Image dialog appears. 

 

5. Select an image to insert and click OK button. 

6. The selected image is displayed on the image boxes on the report.  
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3.4.3 Capturing and Inserting Single Image 

1. Capture Region/Capture Window buttons are displayed when hovering over image box.  

  

 

Capture Region/Capture Window buttons are only displayed when Image Fill option is set 
as Captured.  

2. Click Capture Region/Capture Window button to switch to main module. 

3. Hover over on the View to capture and click Capture button displayed on the View. 

 

 

4. The captured image is displayed in the image box on the report. 
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3.4.4 Capturing and Inserting Multi Image 

1. Capture button is displayed when hovering over image box. 

 

2. Click Capture button to switch to main module. 

3. Hover over on the View to capture and click Capture button displayed on the View. 

   

 

4. The captured image slices are displayed in the image boxes on the report. Also, Reference 
Guide Image box is filled with guide image of the captured image. 
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3.5 Changing Properties 

3.5.1 Changing Properties of Single Image Box 

1. Right click on an image box to display the context menu and click Property, or double click 
the image box. 

  

2. Image Box Property dialog appears. 

 

3. Select Image Fill, Display, and Box Style options. 

▪ Image Capture: The user manually select an image from the captured images 

▪ Auto Fill: Image box is automatically filled with image from the set Source tab with the 
set View selected in drop-down list below. 

4. Click Save button to apply changes. 

3.5.2 Changing Properties of Multi Image Box 

1. Right click on a multi image box to display the context menu and click Property, or double 
click the image box. 
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2. Image Box Property dialog appears. 

 

3. Select Image Fill, Image Table, Display, and Box Style options. 

▪ Image Capture: The user manually select images from the captured images 

▪ Auto Fill: Image boxes are automatically filled with image from the set Source tab with 
the set View selected in drop-down list below 

▪ With Reference Image Box: Image tables includes a Reference Guide Image box 

4. Click Save button to apply changes. 

3.5.3 Changing Properties of Text Box 

1. Right click on a text box to display the context menu and click Property. 

  

2. Text Box Property dialog appears. 

 

3. Change Text Size, Text Color, Box Line Color, Text Alignment, Box Line Type, or Box 
Background Color.  

4. Check Transparent if you want to set box background color as transparent. When the box is 
checked, Box Background Color option is disabled. 

5. Click Save button to apply changes. 
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3.6 Changing Image Slice 

3.6.1 Changing Image of Single Image Box 

1. Right click on an image box to display the context menu and click Change the Image. 

  

 

[Change the Image] is enabled only on a 2D image that its Image Fill option is set to 
Auto Fill. 

2. Select Image dialog appears. 

  

* Thickness and Interval of the image can be changed on Select Image dialog. 

3. Change the slice by scrolling the mouse wheel or using scroll bar. 

4. Click OK button to apply the changed slice. 
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3.6.2 Changing Images of Multi Image Box 

1. Right click on a multi image box to display the context menu and click Change the image. 

  

2. Select Image dialog appears. 

  

* Thickness and Interval of the images can be changed on the dialog. 

3. Click Select button to select an image. 

  

4. Images can be multi-selected by using short cut keys.  

 Shit Key + Click: Continuous selection  

 Ctrl Key + Click: Multiple selection of the selected images 

5. Click OK button to apply the changed slice. 
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3.7 Managing Template  

3.7.1 Changing Template 

1. Select Change Template button to change report template. 

 

2. Click OK to save changes made to current report. 

 

3. Change Template dialog appears. 

 

4. Select the desired template on the Template List and check the selected template on the 
Preview window. 

5. Click OK to apply the selected template. 

6. Image boxes are automatically filled with images from designated diagnosis tab. 

  



Chapter 12. REPORT  
 

338 Ez3D-i User Manual 

3.7.2 Template Master 

1. Click Template Master button to enter Template Master mode. 

  

2. Click OK to save changes made to current report. 

  

3. Report dialog enters to Template Master Mode. 

  

4. Add, Copy and Add, or Edit template as desired. 

 

 

 

 

 

 

Add New blank template is added to insert items as desired 

Copy and Add The selected template is copied and added to the list. 

Edit Image box/Text box/Header/Footer of selected template can be edited 
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5. Right click on template name to view the context menu. 

 

Set Default Template The selected template is set as default template. 

Rename The user can change the template name. 

Delete 

The user can delete the selected template from the list. 

* Please note that the default template and templates provided by 
manufacturer cannot be deleted. 

6. Click Save button to save changes made to the template. 

 

7. Click Close Master Mode button to close Template Master Mode. 

 

8. Click OK when the following dialog appears. 

 

 

3.8 Adding Memo 

3.8.1 Creating Memo 

The user can insert a memo in report.  

1. Click Memo button( ) in toolbar.  

2. Click the desired position to enter memo. 

3. Enter comment in memo input field. You can insert a preset comment by right clicking to run 
context menu during memo input mode. 

4. Enter ESC key or click oust side of memo to exit memo input mode.  
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3.8.2 Adding Memo Preset 

1. Click Memo Preset button( ) in toolbar. 

2. Memo Preset dialog appears.  

 

3. Click Add button to add a Preset. 

4. Preset dialog appears. 

 

5. Enter Title and Preset, and click Save button. 

3.8.3 Modifying Memo Preset 

1. Click Memo Preset button( ) in toolbar. 

2. Memo Preset dialog appears.  

 

3. Select a preset from Preset List and Click Modify button to edit the Preset.  
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4. Preset dialog appears. 

 

5. Edit Title or Preset, and click Save button. 

3.8.4 Deleting Memo Preset 

1. Click Memo Preset button in toolbar. 

2. Memo Preset dialog appears.  

 

3. Select a preset from Preset List and click Delete button to delete the Preset. 

4. Click OK button to confirm when the following message appears. 

 

5. The selected preset is deleted from Preset List. 
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4. Printing Report 

4.1 DICOM Print 

1. Click DICOM Print button on Control Panel after report is completed. 

 

2. Click Save button when DICOM Print dialog appears. 
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4.2 Print 

1. Click Print button on Control Panel after report is completed. 

 

2. Select Use option when Anonymization dialog appears if you want to anonymize patient 

information, and click OK button. 

 

3. Print dialog appears. 

 

4. Click Print button.  
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5. Saving/Exporting Report 

5.1 Saving Report 

1. Click Save Report to DB button. 

  

2. Save Report dialog appears. 

  

3. Enter comments and click OK button.  

 

5.2 Exporting to PDF/DICOM 

1. Select Export on extend tool bar.  

2. Click Export to PDF button( ) or Export to DICOM button( ) on Export tool bar. 

3. Select Use option when Anonymization dialog appears if you want to anonymize patient 
information, and click OK button. 
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4. Set file path, file name, file format on the Save dialog and click Save. 

 

5. The report is exported after being converted into pdf or DICOM file. 

 

5.3 Sending E-mail 

1. Select Export on extend tool bar. 

2. Click Send E-mail button on Export tool bar. 

  

3. Send E-mail dialog appears with files attached. 

 

 

Click [Edit Signature] to save a signature to use when sending emails. If there exists 
a signature previously added, the signature is displayed in the text box. 

4. Fill the To, CC, Subject, and text box to send email. 

5. Select Use for Anonymize Patient Information option if required. 

6. Click Send button to complete sending email.  
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6. Opening/Creating Report 

6.1 Opening Report 

1. Click Open Report button. 

  

2. Open Report dialog appears to show saved reports in DB. 

  

3. Select a report to open and click OK. 

4. The selected report is opened. 
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6.2 Creating a New Report 

1. Click Create New Report button. 

  

2. New report is created and a default template is displayed. 

  

3. If there exists image boxes with Auto Fill option enabled, the following progress bar displays 
to load images. 

  

4. The newly created report is displayed. 

  



Chapter 12. REPORT  
 

348 Ez3D-i User Manual 

7. Tools in the Toolbar 

▪ Main Tools 

Icons Designation Description of Features 

 
Zooming Zoom in or out 

 
Horizontal Fit Fit the report on horizontal axis 

 
Vertical Fit Fit the report on the vertical axis 

 
Edit Image Edit image in image box by zooming and panning 

 Page Size Select the size of Report 

 
Page Setting Set up a page 

▪ Advanced Tools 

Icons Designation Description of Features 

 

Annotation 

Free Draw Draw freely on the 2D image 

 
Rectangle Draw rectangles on the 2D image 

 
Ellipse Draw ellipses on the 2D image 

 
Line Draw lines on the 2D image 

 
Arrow Dray arrows on the 2D image 

 
Memo Write memos directly on images 

 
Memo Preset Set memo presets 

 

Export 

Export to PDF Export as a PDF file 

 
Send E-mail Send email 

 
Export to DICOM Export as a DICOM file. 

 

Etc. 

Grid Check the scale of the image with grid. 

 
Turn Overly On/Off Show/Hide entire input objects 

 
Delete All Delete all input objects 
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